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Health and safety information

Always comply with the following precautions and usage tips to avoid
dangerous situations and ensure peak performance of your camera.

A Safety warnings

WARNING

Do not disassemble or attempt to repair your camera
This may result in electric shock or damage to the camera.

Do not use your camera near flammable or explosive
gases and liquids
Do not use your camera near fuels, combustibles, or flammable

chemicals. Do not store or carry flammable liquids, gases, or explosive

materials in the same compartment as the camera or its accessories.

Keep your camera away from small children and pets

Keep your camera and all accessories out of the reach of small
children and animals. Small parts may cause choking or serious injury
if swallowed. Moving parts and accessories may present physical
dangers as well.

Prevent damage to subjects’ eyesight

Do not use the flash in close proximity (closer than 1 m/3 ft) to people
or animals. Using the flash too close to your subject’s eyes can cause
temporary or permanent damage.

Handle and dispose of batteries and chargers with care

 Use only Samsung-approved batteries and chargers. Incompatible
batteries and chargers can cause serious injuries or damage to your
camera.

 Never dispose of batteries in a fire. Follow all local regulations when
disposing of used batteries.

 Never place batteries or cameras on or in heating devices, such as
microwave ovens, stoves, or radiators. Batteries may explode when
overheated.

» Do not use a damaged power supply cord, plug, or loose outlet when
charging batteries. This may cause fire or electric shock.

A Safety precautions

CAUTION

Handle and store your camera carefully and sensibly

Do not allow your camera to get wet—liquids can cause serious
damage. Do not handle your camera with wet hands. Water damage
to your camera can void your manufacturer’s warranty.

» Do not expose the camera to direct sunlight or high temperatures
for an extended period of time. Prolonged exposure to sunlight
or extreme temperatures can cause permanent damage to your
camera’s internal components.
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+ Avoid using or storing your camera in dusty, dirty, humid, or poorly-
ventilated areas to prevent damage to moving parts and internal
components.

» Remove the batteries from your camera when storing it for an
extended period of time. Installed batteries may leak or corrode over
time and cause serious damage to your camera.

« Prolonged usage of the camera may overheat the battery and raise
the internal temperature of the camera. If the camera stops operating,
remove the battery and allow it to cool down.

« Protect your camera from sand and dirt when using it on beaches or
in other similar areas.

« Protect your camera from impact, rough handling, and excessive
vibration to avoid serious damage.

 Exercise caution when connecting cables or adapters and installing
batteries and memory cards. Forcing the connectors, improperly
connecting cables, or improperly installing batteries and memory
cards can damage ports, connectors, and accessories.

» Do not insert foreign objects into any of your camera’s compartments,
slots, or access points. Damage due to improper use may not be
covered by your warranty.

+ Do not swing your camera by the strap. This may cause injury to
yourself or others.

+ Do not paint your camera, as paint can clog moving parts and prevent
proper operation.

« Paint or metal on the outside of the camera may cause allergic
reactions, itchy skin, eczema, or swelling for people with sensitive
skin. If you experience any of these symptoms, stop using the camera
immediately and consult a doctor.

» Do not use batteries for unintended purposes. This may cause a fire
or electric shock.

Do not touch the flash while it fires. The flash is very hot when fired
and may burn your skin.

+ Keep cards with magnetic strips away from the camera case.
Information stored on the card may be damaged or erased.

Protect batteries, chargers, and memory cards from
damage

+ Avoid exposing batteries or memory cards to very cold or very hot
temperatures (below 0 °C/32 °F or above 40 °C/104 °F). Extreme
temperatures can reduce the charging capacity of your batteries and
can cause memory cards to malfunction.

« Prevent batteries from making contact with metal objects, as this can
create a connection between the + and — terminals of your battery
and lead to temporary or permanent battery damage. Also, this may
cause fire or electric shock.

* Prevent memory cards from making contact with liquids, dirt, or
foreign substances. If dirty, wipe the memory card clean with a soft
cloth before inserting in your camera.
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» Do not allow liquids, dirt, or foreign substances to come in contact
with the memory card slot. Doing so may cause the camera to
malfunction.

* Insert the memory card in the correct direction. Inserting a memory
card in the wrong direction may damage your camera and memory
card.

« Turn off the camera when inserting or removing the memory card.

» Do not bend, drop, or subject memory cards to heavy impact or
pressure.

» Do not use memory cards that have been formatted by other cameras
or by a computer. Format the memory card with your camera.

» Never use a damaged charger, battery, or memory card.

Use only Samsung-approved accessories

Using incompatible accessories may damage your camera, cause injury,
or void your warranty.

Protect your camera’s lens

» Do not expose the lens to direct sunlight, as this may discolor the
image sensor or cause it to malfunction.

* Protect your lens from fingerprints and scratches. Clean your lens with
a soft, clean, debris-free lens cloth.

p Important usage information

Allow only qualified personnel to service your camera

Do not allow unqualified personnel to service the camera or attempt to
service the camera yourself. Any damage that results from unqualified
service is not covered by your warranty.

Ensure maximum battery and charger life

« Overcharging batteries may shorten battery life. After charging is
finished, disconnect the cable from your camera.

« Over time, unused batteries will discharge and must be recharged
before use.

« Disconnect chargers from power sources when not in use.
+ Use batteries only for their intended purpose.

Exercise caution when using the camera in humid
environments

When transferring the camera from a cold environment to a warm and
humid one, condensation may form on the delicate electronic circuitry
and memory card. In this situation, wait for at least 1 hour until all
moisture has evaporated before using the camera.

Check that the camera is operating properly before use

The manufacturer takes no responsibility for any loss of files or damage
that may result from camera malfunction or improper use.
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Concepts in Photography

Shooting postures

A correct posture for stabilizing the camera is necessary for taking a
good photo. Even if you hold a camera correctly, the wrong posture
can cause the camera to shake. Stand up straight and remain still to
maintain a steady base for your camera. When shooting with a low
shutter speed, hold your breath to minimize body movement.

Holding the camera

Hold the camera with your right hand and place you right index finger
on the shutter button. Place your left hand under the lens for support.

Standing photography

Compose your shot; stand up straight with your feet shoulder-length

apart, and keep your elbows pointed down.
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Crouching photography Aperture

Compose your shot, crouch with one knee touching the ground, and

: The aperture, a hole that controls the amount of light that enters the
keep a straight posture.

camera, is one of the three factors that determine the exposure. The
aperture housing contains thin, metal plates that open and close to let
light through the aperture and into the camera. The size of the aperture
is closely related to the brightness of a photo: the larger the aperture,
the brighter the photo; the smaller the aperture, the darker the photo.

Aperture sizes

Darker photo Brighter photo
(aperture opened slightly) (aperture opened wide)
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The size of the aperture is represented by a value known as an
“F-number.” The f-number represents the focal length divided by the
diameter of the lens. For example, if a lens with a 50 mm focal length
has an f-number of F2, the diameter of the aperture is 25 mm. (50
mm/25 mm=F2) The smaller the f-number, the greater the size of the
aperture.

The opening in the aperture is described as the Exposure Value (EV).
Increasing the Exposure Value (+1 EV) means the amount of light
doubles. Decreasing the Exposure Value (-1 EV) means the amount of
light halves. You can also use the exposure compensation feature to
fine-tune the amount of light by subdividing exposure values into 1/2,
1/3 EV, and so on.

+1EV -1EV

!

F2 F2.8 F4

Exposure Value Steps

Aperture value and the depth of field

You can blur or sharpen the background of a photo by controlling the
aperture. It is closely related to the depth of field (DOF), which can be
expressed as small or large.

A photo with a large DOF A photo with a small DOF

The aperture housing contains several blades. These blades move together

m and control the amount of light passing through the center of the aperture.
The number of blades also affects the shape of light when shooting night
scenes. If an aperture has an even number of blades, light divides into an
equal number of sections. If the number of blades is odd, the number of
sections is double the number of blades.

For example, an aperture with 8 blades divides light into 8 sections and an
aperture with 7 blades into 14 sections.

7 blades 8 blades
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Shutter speed

Shutter speed refers to the amount of time it takes to open and close
the shutter, and it is an important factor in the brightness of a photo, as it
controls the amount of light which passes through the aperture before it
reaches the image sensor.

Usually, the shutter speed is manually adjustable. The measurement

of the shutter speed is known as the “Exposure Value” (EV), which is
marked in intervals of 1's, 1/2 s, 1/4 s, 1/8 s, 1/15s, 1/1000 s, 1/2000 s,
and so on.

+1 EV

Exposure

1s 1/2s 1/4s 1/8s 1/15s 1/30s

Shutter Speed

The numbers indicated on the camera are the denomi :
exposure values, which means that the higher the number, the less light
will be let in. Likewise, the smaller the EV number, the more light will be
let in.

As the photos below illustrate, a slow shutter speed allows more time
to let light in, so the photo becomes brighter. On the other hand, a fast
shutter speed allows less time to let light in and the photo becomes
darker and more easily freezes subjects in motion.

0.8s 0.004 s
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ISO sensitivity

The exposure of an image is determined by the sensitivity of the
camera. This sensitivity is based on international film standards, known
as ISO standards. On digital cameras, this sensitivity rating is used

to represent the sensitivity of the digital mechanism that captures the
image.

ISO sensitivity doubles as the number doubles. For example, an ISO
200 setting is capable of capturing images at twice the speed of an ISO
100 setting. However, higher ISO settings can result in “noise” —small
specks, spots, and other phenomena in a photo that give the shot

a noisy or dirty appearance. As a general rule, it is best to use a low
ISO setting to prevent noise in your photos, unless you are shooting in
darkened environments or at night.

Changes in the quality and brightness according to ISO sensitivity

Because a low ISO sensitivity means the camera will be less sensitive
to light, you need more light to have an optimal exposure. When using
a low ISO sensitivity, open the aperture more or reduce the shutter
speed to allow more light to enter the camera. For example, on a sunny
day when light is abundant, a low ISO sensitivity does not require a low
shutter speed. However, in a dark place or at night, a low ISO sensitivity
and a fast shutter speed will result in a blurry photo.

A photo captured with a tripod and A blurred photo with a low ISO sensitivity
high sensitivity
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How the aperture setting, shutter speed,
and ISO sensitivity control exposure

The aperture setting, shutter speed, and ISO sensitivity are closely
interconnected in photography. The aperture setting controls the
opening that regulates the light that enters the camera, while the shutter
speed determines the length of time that light is allowed to enter.

ISO sensitivity determines the speed at which the film reacts to light.
Together, these three aspects are described as the triangle of exposure.

A change in shutter speed, aperture value, or ISO sensitivity can be
offset by adjustments to the others to maintain the amount of light.
The results, however, change according to the settings. For example,
shutter speed is useful in expressing movement, aperture can control
the depth of field, and ISO sensitivity can control the graininess of a
photo.

T

Wide aperture

= more light
Narrow aperture
= less light

Aperture

Wide = small depth of field
Narrow = large depth of field

Shutter speed

Settings

Fast speed
= less light
Slow speed
= more light

Results

Fast = still
Slow = blurry

ISO sensitivity

High sensitivity

= more sensitive to light
Low sensitivity

= less sensitive to light

High = more grainy
Low = less grainy
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Correlation between focal length, angle,
and perspective

Focal length, which is measured in millimeters, is the distance between
the middle of the lens to its focal point. It affects the angle and
perspective of captured images. A short focal length translates into a
wide angle, which allows you to capture a wide shot. A long focal length
translates into a narrow angle, which allows you to capture telephoto
shots.

Short focal length

wide-angle lens

wide shot

wide angle

telephoto lens

telephoto shot

narrow angle

Look at these photos below and compare the changes.

18 mm angle 55 mm angle 200 mm angle

Normally, a lens with a wide angle is suitable for shooting landscapes and
a lens with a narrow angle is recommended for shooting sports events or
portraits.
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Depth of field

Portraits or still-life photos mostly acclaimed by people are the ones on
which the background is out of focus so the subject looks pronounced.
Depending on the focused areas, a photo can be blurred or sharpened.
This is called ‘a low DOF’ or ‘a high DOF’.

The depth of field is the focused area around the subject. Therefore,
a small DOF signifies that the focused area is narrow and a large DOF
means the focused area is wide.

A photo with a small DOF, which stresses the subject and makes the
rest of it blurred, can be obtained by using a telescope lens or selecting
a low aperture value. Conversely, a photo with a large DOF which
shows all the elements on the photo sharply focused can be achieved
by using a wide angle lens or selecting a high aperture value.

Small Depth of Field Large Depth of Field

What controls out-of-focus effects?

DOF depends on aperture value

The wider the aperture is (namely the lower the aperture value), the
lower the DOF becomes. Under the condition where the other values
including shutter speed and ISO sensitivity are equal, a low aperture
value leads to a photo with a low DOF.

55 mm F5.7 55 mm F22
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DOF depends on focal length DOF depends on the distance between the sub

the camera
The longer the focal length is, the lower the DOF gets. A telescope lens

with a longer focal length than a telescope lens with a short focal length The shorter the distance between the subject and the camera is, the
is better to capture a photo of a low DOF. lower the DOF gets. Therefore, taking a photo close to a subject can
result in a photo of low DOF.

A photo captured with a 100 mm telescope lens

A photo captured with a 18 mm telescope A photo captured with a 100 mm
lens telescope lens

A photo captured close to the subject
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DOF preview

You can use the Depth preview button to get an idea of what your shot
will look like before shooting. When you press the button, the camera
adjusts the aperture to the predefined settings and shows the results on
the screen.

Composition

It is fun to capture a photo of the beauty of world with a camera.
matter how the world is beautiful, however, a poor composition cannot
capture the beauty of it.

When it comes to composition, it is very important to prioritize subjects.

Composition in photography means arranging objects in a photo.
Usually, abiding by the rule of thirds leads to a good composition.

Rule of Thirds

To use the rule of thirds, divide the image into a 3x3 pattern of equal
rectangles.

To compose photos that best emphasize the subject, make sure the
subject is located at one of the corners of the center rectangle.

20
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Using the rule of thirds will create photos with stable and compelling Photos with two subjects

compositions. Below are a few examples. — .
If your subject is in one corner of the photo, it creates an unbalanced

— = composition. You can stabilize the photo by capturing a second subject
in the opposite corner to balance the weight of the photo.

Unstable Stable

When taking landscape photos, centering the horizon will create an
unbalanced effect. Give more weight to the photo by moving the
horizon up or down.

Subject 1

Unstable Stable
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Flash

Light is one of the most important components in photography. It’s
not easy, however, to have an enough amount of light anytime and
anywhere. Making use of a flash allows you to optimize light settings
and create a variety of effects.

Flash, also known as strobe or speed light, helps to create adequate
exposure in low-light conditions. It is also useful in light-abundant
situations. For example, flash can be used in compensating the
exposure of a subject’s shadow or capturing clearly both the subject
and the background in backlit conditions.

Before correction After correction

Flash guide number

The model number of a flash refers to the flash’s power, and the
maximum amount of light created is represented by a value known

as a “guide number.” The bigger the guide number, the more light is
emitted from the flash. The guide number is achieved by multiplying the
distance from the flash to the subject and the aperture value when the
ISO sensitivity is set to 100.

Guide number = Flash to Subject Distance X Aperture value
Aperture value = Guide number / Flash to Subject Distance
Flash to Subject Distance = Guide number / Aperture value

Therefore, if you know the guide number of a flash, you can estimate an
optimum flash to subject distance when setting the flash manually. For
example, if a flash has a guide number of GN 20 and is 4 meters away
from the subject, the optimal aperture value is F 5.0.
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Bounce Photography

Bounce photography refers to the method of photography which
redirects the light from the subject to the ceiling or walls so that the
light spreads evenly. Normally, photos captured with flash may appear
unnatural and cast shadows. Subjects in photos captured with bounce
photography cast no shadows and look smooth due to evenly spread
light.




My Camera

Learn about your camera’s layout, display icons, basic functions, supplied lens,
and optional accessories.
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Unpacking

Check your product box for the following items.

Camera USB cable Recharable battery
(including the body cap, eye-cup,
and hot-shoe cover)

Software CD-ROM User manual Basic Operation Strap
(User manual included)

/ ¢ The illustrations may differ from your actual items.
* You can purchase optional accessories at a retailer or a Samsung service center. For information

about accessories, refer to page 142.



My Camera

Green button ®

Reset the value of Program Shift,
Picture Wizard, White Balance, Color
Temperature, Display Color, Timer,
Flash EV, Selection AF (a repositioned
focus area is moved back to the
center), or exposure compensation in
individual function menus.

Jog dial

Move to a desired direction in the menu
screen, adjust aperture value or shutter
speed in some shooting modes, and
change the size of a focus area.

Mode dial

o Caviarr: Smart Auto mode (p. 39)
* P: Program mode (p. 40)

* A: Aperture Priority mode (p. 41)
« S: Shutter Priority mode (p. 41)

* M: Manual mode (p. 42)

* D: Lens Priority mode (p. 42)

+ [@@: Sound Picture mode (p. 45)
* [a)): Panorama mode (p. 45)

* SCENE: Scene mode (p. 46)

@8 Movie mode (p. 48)

4 | Hot-shoe cover

5 | Hot-shoe

6 | Built-in flash (p. 71)

7 | Speaker

8 | Flash pop-up button (p. 71)
9 | Microphone

10 | Image sensor

11 | Lens release button

12 | Lens mount

13 | Depth preview button (p. 20)
14 | Lens mount index

15 | AF-assist light/Timer lamp
16 | Power switch

17 | Shutter button




15
14

13
12
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AEL button AEL (p. 94)

* In Shooting mode: Lock the
adjusted exposure value or focus.

* In Playback mode: Protect the
displayed file.

Playback button ]
Enter Playback mode.

Memory card cover

S"MSUNG

1 Drive mode button @)

EV adjust button 4 (p. 77)
2 Press and hold [E4], and then scroll the
jog dial to adjust the exposure value.

Navigation button
* In Shooting mode
- AF-MF: Select an AF Mode
- IS0: Select an ISO value
- [ES): Select a metering mode
- WB: Select a White Balance
* In other situations
Move up, down, left, right,
respectively.

Status lamp

 Blinking: When saving a photo,
shooting a video, sending data to a
computer or printer.

» Steady: When there is no data
transfer or when data transfer to a
computer or printer is complete.

10

Fn button Fn
Access major functions and fine-tune
some settings.

Delete/Picture Wizard button 4 /<4
* In Shooting mode: Access Picture
Wizard.

* In Playback mode: Delete files.

11

DISP button DISP

* In Shooting mode: View camera
settings and change options.

* In Playback mode: View photo
information.

12

Viewfinder

OK button

» Confirm the highlighted option or
menu.

» Allow you to select a focus area
manually.

13

Eye-cup

14

Eyelet for camera strap

15

MENU button MENU
Acces menus.
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7 . 1 Battery chamber cover Shutter release port
A\ ¢ = Insert a memory card and battery. 5 Use a shutter release cable with a

tripod to minimize camera movement.

2 | Tripod mount

i HDMI port
Display
P t rt
USB and A/V port 7 ower adapter po
4 | Connect the camera to other devices 8 | Proximity sensor (p. 98)
via a USB A/V cable.

Diopter adjustment dial

If the image is not shown clearly

9 | through the viewfinder, scroll the
diopter adjustment dial to improve the
view.
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In Shooting mode

Capturing photos

2. Shooting options (right)

:
ﬁ 4 10:00AU 20110101 @  Drive mode (4] Histogram (p. 93)
= L SAF | AF mode (p. 59) [ O Shooting mode
" R=ar White Balance (p. 54) Y Focus
@ E:J] [E 2 g White Balance micro adjustment 4% Flash indicator
5 ; %’L ISO sensitivity (p. 53) 4o Shutter speed
\&J E 52/_% Metering (p. 73) F3a5 Aperture value
@ o% YD F35 7209120 ARODIO GWe— 3 -:Z,: Picture Wizard (p. 57) Exposure value
‘Cag | Face tone AEL Auto exposure lock (p. 94)
1. Shooting options (left) ‘Y | Face retouch AFL Auto focus lock (p. 94)
7] Memory card not inserted
14m | Photo size 3. Shooting information ooio Available number of photos
EE | Photo quality @ : Fully charged
Focus area option 4 GPS activated* (o9 (W (9: Partially charged
8, Face detection 10:00AM | Time gtt(;i?): Empty (recharge the
Flash option 2011.01.01 | Date * These icons appear when you attach an optional GPS
@ | Flash intensity London | Location information* module.
Color space i Focus aid bar (p. 65)
B Smerarce o 79 | Asooous fams PRk o
Wy | Optical Image Stabilization (OIS) (p. 76) [ ] Spot metering area

Camera shake
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Recording videos

1. Shooting options (left) 3. Shooting information
- 1
o Standby 00w 20110101 Video size 10:00AM | Time
i L= B | Video quality 20110101 | Date
" TR | Fader (p. 79) (4] Histogram (p. 93)
8 & Voice recording on (p. 80) o Shooting mode
. ¥ | Cutwind sound (p. 80) CAF Auto focus activated
\&, ey Optical Image Stabilization (OIS) (p. 76) F3s5 Aperture value
o o -3 Exposure value
2. Shooting options (right) AEL Auto exposure lock (p. 94)
AFL Auto focus lock (p. 94)
.| Drive mode [ ] Memory card not inserted
CAF, | AF mode (p. 59) 00:00:10 | Available recording time
AWB White Balance (p. 54) @ Fully charged
Metering p. 79 (003 g(gd:)'P Sﬂsg (igjgr}ge the
By Picture Wizard (p. 57) battery) '

/ The icons displayed will change according to
the mode you select or the options you set.
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In Playback mode

Viewing photos

) & om 100 0001

London

Information

P /40 F35 200 0OOO1/0 1000 &

T s —

Location information

-1.||I Volume
RAW file
E Print information added to file (p. 106)
(2o Sound picture file (p. 45)
Omn Protected file
100-0001 Folder number - File number
London Location information
1740 Shutter speed
F35 Aperture value
200 ISO value

pooo o 1ooo | Current file/The total number of files

o Dosorption

1 Captured photo
2 | RGB histogram (p. 93)
Shooting mode, Metering, Flash,
3 White Balance, Picture Wizard,
RAW file, Focus range, Exposure value,
Photo size, Date
Shutter speed, Aperture value, ISO
4 value, Current file/The total number of

files

Playing videos

» PLAY o,

100-0002

{0k Pause 12 Stop
il Volume
100-0002 | Folder number - File number
00:30 Current playback time
10:00 Video length
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You can purchase optional lenses made exclusively for your NX series
camera. Learn about the functions of each lens and select one that suits
your needs and preferences.

No. ‘ Description

LLens mount index

Zoom ring

Focus ring (p. 65)

Lens hood mount index

Lens layout

Lens
SAMSUNG 18-55 mm F3.5-5.6 OIS Il lens (example)

iFn button (p. 43)

AF/MF switch (p. 59)

o N O, WOWDN -

Lens contacts
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SAMSUNG 20-50 mm F3.5-5.6 ED lens (example) Locking or unlocking the lens

To lock the lens, pull and hold the zoom lock switch away from the
camera body and rotate the zoom ring clockwise.

Lens mount index

Zoom lock switch

Zoom ring

Lens

Focus ring (p. 65)

iFn button (p. 43)

m Description
1
2
3
4
5
6
7

Lens contacts
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To unlock the lens, rotate the zoom ring counter-clockwise until you hear SAMSUNG 20 mm F2.8 lens (example)
the click.

m You cannot capture a photo when the lens is locked.

iFn button (p. 43)

Lens mount index

Focus ring (p. 65)

Lens

m Description
1
2
3
4
5

Lens contacts
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Lens markings

Aperture value
A range of supported aperture values. For example, F 1:4-5.6
means the maximum aperture value range from 4 to 5.6.

Find out what the numbers on the lens signify. 1

SAMSUNG 50-200 mm F4-5.6 ED OIS Il lens (example) Focal length

The distance from the middle of the lens to its focal point (in
millimeters). This figure is expressed in a range: minimum focal
2 length to maximum focal length of the lens.

T \ H [[]11 Longer focal lengths result in narrower angles of view and the

effective in minimizing chromatic aberration (a distortion that occurs

1455 50- 200 wosow | subject is magnified. Shorter focal lengths result in wider angles of
T Tl VIew.
I I | I I I I I I I ED
1:4-5.6 50-200 ED 0IS @52 3 ED stands for Extra-low Dispersion. Extra-low dispersion glass is
\

NN I when a lens fails to focus all colors to the same convergence point).

|& J

o 2 3 45 OIS (p. 76)

4 Optical Image Stabilization. Lenses with this feature can detect
camera shake and effectively cancel out the movement inside the
camera.

@
5 The lens diameter. When you attach a filter to the lens, make sure
that the diameters of the lens and the filter are the same.
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You can purchase additional accessories including external flash and No. ‘ Desoription

GPS module that can help you capture better and more convenient
READY lamp/Test button

photos.
[MODE] button

For more information, refer to the manual for each accessory.
Power button

Hot-shoe fastening dial

a The illustrations below may differ from the actual items.
Hot-shoe connection

Battery cover

~N o gl OIN| -~

Bulb

External flash layout

Connecting the flash

1 Remove the hot-shoe cover from the camera.
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C Connect the flash by sliding it into the hot-shoe. Y Press the power button on the flash.

GPS module layout

3 Lock the flash into place by turning the hot-shoe fastening
dial clockwise towards LOCK.

No. ‘ Description

Status lamp

Power button

Hot-shoe fastening dial

Hot-shoe connection

b wWN| -

Battery cover
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Attaching the GPS module 3 Lock the GPS module into place by turning the hot-shoe
fastening dial clockwise towards LOCK.

1 Remove the hot-shoe cover from the camera.

Y Press the power button of the GPS module.
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Two simple shooting modes—Smart Auto and Scene mode—help you
capture photos with numerous automatic settings. Additional modes
allow for greater customization of settings.

[ofo]] Description

Gisrr | Smart Auto mode (p. 39)
Program mode (p. 40)

Aperture Priority mode (p. 41)

Shutter Priority mode (p. 41)

Manual mode (p. 42)

Lens Priority mode (p. 42)

y | Sound Picture mode (p. 45)

Mo 2w

(M | Panorama mode (p. 45)

SCENE | Scene mode (p. 46)

ik Movie mode (p. 48)

G Smart Auto mode

In Smart Auto mode, the camera recognizes surrounding conditions
and automatically adjusts factors that contribute to exposure, including
shutter speed, aperture value, metering, White Balance, and exposure
compensation. As the camera controls most of the functions, some
shooting functions are limited. This mode is useful for capturing quick
snapshots with the least amount of adjustment.
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P Program mode

The camera automatically adjusts shutter speed and aperture value so ProgramIShift function lets you adjust the shutter speed and aperture

that an optimal exposure value can be achieved. value while the camera maintains the same exposure. When you rotate
the jog dial to the left, the shutter speed decreases and the aperture

This mode is useful when you want to capture shots of constant value increases. When you rotate the jog dial to the right, the shutter

exposure while being able to adjust other settings. speed increases and the aperture value decreases.




My camera > SN00tiNg modes

A Aperture Priority mode S Shutter Priority mode

In Aperture Priority mode, the camera automatically calculates shutter In Shutter Priority mode, the camera automatically adjusts the aperture
speed according to the aperture value you choose. You can adjust the value according to the shutter speed you choose. This mode is useful
depth of field (DOF) by changing the aperture value. This mode is useful for capturing photos of fast-moving subjects or for creating tracer

for taking portraits and landscape shots. effects in a photo.

For example, set the shutter speed to over 1/500 s to freeze the
subject. To make the subject appear blurred set the shutter speed to
below 1/30 s.

Large Depth of Field Small Depth of Field

Slow shutter speed Fast shutter speed
In low-light settings, you may need to increase the ISO sensitivity to prevent .
/ blurred photos. In order to compensate for the reduced amount of light allowed by fast
/ shutter speeds, open the aperture and let in more light. If your photos are still

too dark, increase the ISO value.



vy camera > SN00tiING modes

M Manual mode

Manual mode lets you adjust the shutter speed and aperture value
manually. In this mode, you can fully control the exposure of your
photos.

This mode is useful in controlled shooting environments, such as a
studio, or when it is necessary to fine-tune camera settings. The Manual
mode is also recommended for shooting night scenes or fireworks.

Framing mode

When you adjust the aperture value or shutter speed, the exposure
changes according to the settings, so the display may darken. With this
function on, the brightness of the display is constant regardless of the
settings, so you can better frame your shot.

To use Framing In Shooting mode, press [MENU] » (3)s » Framing Mode
Mode, » Off or On.

Using bulb

Use a bulb to shoot night scenes or the night sky. While you are
pressing [Shutter], the shutter is left open so you can create moving
light effects.

Completely scroll the jog dial to the left to Bulb. B> Press and

Lt ) hold [Shutter] for the desired time.

@ Lens Priority mode
Using the i-Scene mode

You can select an appropriate scene (i-Scene) to the lens you attached.
Available scenes may differ depending on the lens you are using.

|1 Attach an iFn lens.
C Rotate the mode dial to .

3 Press [iFn].
« You can also use this function by pressing [Fn].
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Y Adjust the focus ring to select a scene. Using i-Function in P A SM modes
+ You can also use the navigation button to select a scene.

When you use the iFn button on an iFn lens, you can manually select

and adjust shutter speed, aperture value, exposure value, ISO sensitivity,
and White Balance on the lens.

| Press [iFn] on the lens to select a setting.
+ You can also scroll the jog dial to select a setting.

Backlight

5 Fully press [Shutter] to capture the photo.

AUTO 100

m 0 \ @‘ALTO I

200 4

Available scene modes (for SAMSUNG 18-55 mm F3.5-5.6 OIS Il lens) :
/ Beauty Shot, Portrait, Children, Backlight, Landscape, Sunset, Dawn,
Beach & Snow, Night
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C Adjust the focus ring to select an option. Available options
« You can also use the navigation button to select an option. -“““
e 57 . 0 0

Shutter speed -

Aperture value - - O

Exposure value

White Balance
ISO

(ORNONNG)

(ORNONNORNG)

(ORNONNG®)
O

/ To select items to appear when you press [iFn] on the lens in Shooting mode,
press [MENU] » ¢35 B> Lens i-Function P> an option B Off or On.

3 Fully press [Shutter] to capture the photo.
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(84 Sound Picture mode

In Sound Picture mode, you can add a voice memo before and after
capturing a photo. You can record a voice memo for 10 seconds at
maximum before and after pressing [Shutter] respectively.

(#e YO F3! 0010/ @w

a To set the recording time, press [MENU] » (©): » Sound Rec Time.

M\ Panorama mode

In Panorama mode, the camera captures and combines a series of
photos to create a panoramic image. After pressing [Shutter], slowly
move the camera to one of the directions shown on the screen. The
camera automatically captures photos and saves it as a single photo.

A
Eg

A
&< >
i
)
(b 0010
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SCENE Scene mode

In Scene mode, the camera selects the best settings for each type of
scene.

You can select a desired scene by pressing [Fn] in Shooting mode.

Option ‘ Description

’ﬁ Beauty Shot: Hide facial
imperfections

Portrait: Automatically detect and
(‘ focus on human faces so that you
can achieve clear, soft portraits

Children: Make children appear more
noticeable by capturing their clothes
and the background vividly

(&

N\
N

Sports: Capture fast moving subjects

'.‘:Q Backlight: Capture backlit subjects
Close Up: Capture detailed parts of
$ a subject or small subjects, such as

flowers or insects

Text: Clearly capture text from printed | WPHMD'M%
or electronic documents A
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A Landscape: Capture still-life scenes ,,) Night: Capture scenes at night or in
and landscapes low lighting
a Sunset: Capture scenes at sunset, . . ] )
= | with natural-looking reds and yellows S ;'rs‘gﬁtrks' Capture colorful fireworks
L) |

Dawn: Capture scenes at sunrise

Beach & Snow: Reduce
V‘ underexposed photos due to sunlight
reflected from sand or snow




My camera > SN0OtiING modes

i Movie mode a

In Movie mode, you can shoot videos in High Definition (1280X720) and
capture sound via the camera’s microphone.

In order to adjust the exposure level, you can select Program in
the Movie AE Mode options menu so that the aperture value can
be automatically set or select Aperture Priority to manually set the
aperture value. While shooting a video, press [Depth Preview] to
activate or deactivate the AF function.

Select Fader in the Movie AE Mode options menu to fade in or out a
scene. You can also select Wind Cut to prevent some surrounding
noise from being recorded and select Voice to mute or un-mute voice.

The camera lets you capture video files up to 25 minutes in length and
saves the files in MP4 (H.264) format.

H.264 (MPEG-4 part10/AVC) is the latest video coding format established
in 2003 collaboratively by ISO-IEC and ITU-T. Since this format uses a high
compression rate, more data can be saved in less memory space.

If you have the image stabilizer option on when shooting a movie, the
camera may record the image stabilizer sound.

The zoom sound may be recorded if you use the zoom while recording a
video.

If you remove the camera lens while recording a movie, the recording will
be interrupted. Do not change the lens while recording.

If you change the shooting angle of the camera suddenly while shooting

a movie, the camera may not be able to record images accurately. Use a
tripod to minimize camera shake.

In Movie mode, the camera supports only the Multi AF function. You
cannot use any other focus area setting functions, such as Face Detection
AF.

When the size of a movie file exceeds 4GB, the camera automatically
stops recording. If this occurs, continue shooting by starting a new movie
file.

If you use a slow writing memory card, the recording of your movie can be
interrupted because the card cannot process data at the rate the video is
being shot. If this occurs, replace the card with a faster memory card or
reduce the image size (for example, from 1280X720 to 640X480).

When formatting a memory card, always format using the camera. If you
format on another camera or a PC, you can lose files on the card or cause
a change in the capacity of the card.
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Available functions by shooting mode

For details about shooting functions, see Chapter 2.

Function

OIS (p. 76)

Available in

P/A/S/M/@ /(24 /(sh)/SCENE/
B/ Ginrr ™

AF Lamp (p. 93)

P/A/S/M/®/(3«/(ah)/SCENE/
Dm/rs‘l\-nART

Exposure compensation (p. 77) P/A/S/@/SCENE/»38
Exposure/focus lock (p. 78) P/A/S/ 8
Noise Reduction (p. 92) P/A/S/M

Size (p. 51) %@gm/@/@vscmw
Quality (p. 52) zéé\l/ES*//Pﬁ./@/@)/@/
ISO (p. 53) P/A/S/M

White Balance (p. 54) P/A/S/M/8

Picture Wizard (p. 57) P/A/S/M/8

Color Space (p. 58) :t/:lﬁ\l/ES/:’g: 9/@)/ (aah)/
AF Mode (p. 59) P/A/S/M/®/SCENE/»88*
AF Area (p. 61) P/A/S/M/®@/SCENE*

AF Priority (p. 64) P/A/S/M

MF Assist (p. 65)

P/A/S/M/@ /(3«0 /(ah)/SCENE/
B8/ Chiarr

Drive (Continuous/Burst/Timer/BKT)
(p. 66)

P/A/S/M/®*/(84*/SCENE*/
;W*/fs‘n‘mm*

Flash (p. 70)

P/A/S/M/®*/SCENE*/Cahinrr*

Smart Range (p. 75)

P/A/S/M

Metering (p. 73)

P/A/S/M/H&

* Some functions are limited in these modes.



Shooting Functions

Learn about the functions you can set in Shooting mode.
You can enjoy more customized photos and videos by using the shooting functions.
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As you increase the resolution, your photo or video will include more _ Recommended for

pixels, so it can be printed on larger paper or displayed on a larger Printin .
. ! o ) . . g on A1 paper or viewing on an
screen. When you use a high resolution, the file size will also increase. [ | 12M 4592X2584 (16:9) | |\ oy
Select a low resolution for photos that will be displayed in a digital Printi A3 o
picture frame or uploaded to the web. 8M 3872X2176 (16:9) Hr[')nT'\r;g ON A2 paper orviewing on an
) Printing on A4 paper or viewing on an
[Bu] | 5M 3008X1688 (16:9) LDTV.
) Printing on A5 paper or viewing on an
Y [Zm] | 2M 1920X1080 (16:9) HOTV
g y- 9M | 9M 3056X3056 (1:1) Printing a square photo on A2 paper.
4
Y & 6.7mM | 6.7M 2592X2592 (1:1) Printing a square photo on A3 paper.
/” ' am
' ‘ ‘ *M | 4M 2000X2000 (1:1) Printing a square photo on A4 paper.
1.6mM | 1.6M 1280X1280 (1:1) Printing a square photo on A5 paper.

Tosot thesize: In Shootmg mode, press [Fn] » Photo Size or Movie Size
» an option.

Video size options

. . Icon Size Recommended for
Photo size Optlons 1280 (16:9) Viewing on an HDTV.
Icon ‘ Size ‘ Recommended for 640 | 640 (4:3) Viewing on a TV.
14m | 14M 4592X3056 (3:2) Printing on A1 paper. 320 | 320 (4:3) Uploading on the web.
10m | 10M 3872X2592 (3:2) Printing on A2 paper.
6M | 6M 3008X2000 (3:2) Printing on A3 paper.

2M | 2M 1920X1280 (3:2) Printing on A5 paper.
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The camera saves photos in either the JPEG or RAW format.

Photos captured by a camera are often transformed to the JPEG format
and stored in the memory according to the settings of the camera at the
time of shooting. RAW files are not transformed to the JPEG format and
are stored in the memory without any changes.

RAW files have the file extension “SRW”. To adjust and calibrate
exposures, White Balances, tones, contrasts, and colors of the RAW
files, or to convert them into JPEG or TIFF format, use the Samsung
RAW Converter program found on the supplied CD-ROM. Ensure you
have enough available memory to save photos in the RAW format.

To set the quality, In Shooting mode, press [Fn] » Quality > an option.

Photo quality options

Super Fine:
@g} JPEG » Compressed for the best quality.
* Recommended for printing in large size.
Fine:
@ JPEG » Compressed for better quality.
* Recommended for printing in normal size.

R

JPEG

Normal:
* Compressed for normal quality.

* Recommended for printing in small size or
uploading to the web.

RAW

RAW:
* Save a photo without data loss.
* Recommended for editing after shooting.

S.FINE

RAW+JPEG

RAW + S.Fine: Save a photo in both the JPEG
(S.Fine quality) and RAW format .

FINE

RAW+JPEG

RAW + Fine: Save a photo in both the JPEG
(Fine quality) and RAW format.

NORMAL

RAW+JPEG

RAW + Normal: Save a photo in both the JPEG
(Normal quality) and RAW format.

Video quality options

Option | Extension Description
E‘, MP4 (H.264) Normal: Record videos in normal quality.
@R | MP4 (H.264) | HQ: Record videos in high quality.
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The ISO sensitivity value represents the sensitivity of camera to light.

The larger the ISO value, the more sensitive the camera is to light.
Consequently, by selecting a higher ISO sensitivity value, you can
captured photos in dim or dark places at faster shutter speeds.
However, this may increase electronic noise and result in a grainy photo.

To set ISO . .
In Shooting mode, press [ISO] »> an option.

Examples

ISO 100

* Increase the ISO value in places where flash use is prohibited. You can
a capture a clear photo by setting a high ISO value without having to secure
more light.
* Use the Noise Reduction function in order to reduce the visual noise that
can appear on photos of a high ISO value. (p. 92)

ISO 800 ISO 3200
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The color of a photo depends on the type and quality of the light source.
If you want the color of your photo to be realistic, select an appropriate
lighting condition to calibrate the White Balance, such as Auto WB,
Daylight, Cloudy, or Tungsten, or adjust color temperature manually.
You can also adjust color for the preset light sources so that the colors
of the photo match the actual scene under mixed lighting conditions.

To set the White , .
In Shooting mode, press [WB] P> an option.

White Balance options

opionssopion

Auto WB*: Use automatic settings depending on the lighting

AWB -
conditions.

Daylight*: Select when taking outdoor photos on a sunny day.
-@- | This option results in photos closest to the natural colors of the
scene.

Cloudy*: Select when taking outdoor photos on a cloudy day or
& | in shadows. Photos captured on cloudy days tend to be more
pbluish than on sunny days. This option offsets that effect.

Fluorescent White*: Select when shooting under a daylight
e | fluorescent lamp. Especially for white fluorescent light with a
color temperature of about 4200K.

N
L]

Fluorescent NW*: Select when shooting under a daylight
fluorescent lamp. Especially for white fluorescent light of very
white hues with a temperature of about 5000K.

s
1bRF
b

Fluorescent Daylight™: Select when shooting under a daylight
fluorescent lamp. Especially for white fluorescent light of slightly
bluish hue with a temperature of about 6500K.

Tungsten*: Select when taking indoor photos under
incandescent bulbs or halogen lamps. Incandescent tungsten
bulbs tend to have a reddish hue. This option offsets that effect.

Flash WB*: Select when using a flash.

Custom Set:

Use your pre-defined settings.

You can manually set the White Balance by shooting a white
sheet of paper. Fill the spot metering circle with the paper and
set the White Balance.

* These options can be customized.
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| Option | Description Customizing preset options

Color Temp.. You can also customize preset White Balance options. In Shooting

Manually adjust thg color temperaturg of the light sogroe. mode, press [MENU] » ) or 1 > White Balance » an option,
Color temperature is a measurement in degrees Kelvin
and then press [Fn].

that indicates the specific type of light source. As the color

temperature increases, the color distribution becomes cooler.
Alternatively, as the color temperature decreases, the color Nol
distribution becomes warmer.

10,000 K — Clear sky
8,000 K
— Fluorescent_H
3 6,000 K — — Cloudy
5,000 K — — Daylight
— Fuorescent_L m— Back HL Reset
4,000 K —
— Halogen lam
3,000 K — 9 P
— Tungsten
2,000 K Candle light
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Examples

Daylight

Fluorescent Daylight Tungsten
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Picture Wizard lets you apply different photo styles to your photo to Examples
create various looks and emotional moods. You can also create and
save your own photo styles by adjusting color, saturation, sharpness,
and contrast for each style.

There is no rule for which style is suitable in which conditions.
Experiment with different styles and find your own settings.

To set a photo style, In Shooting mode, press [¢/2] ®> an option.

Standard Vivid Portrait

Landscape Forest

Cool Classic

You can also adjust the value of the preset style settings. Select a Picture
/ Wizard option, press [AF-MF], and then adjust color, saturation, sharpness, or
contrast.



Shooting Functions

Digital imaging devices such as digital cameras, monitors, and printers
have their own methods for representing colors, which are called color
spaces.

Your camera lets you select two color spaces: sRGB or Adobe RGB.

sRGB is widely used for creating colors on PC monitors and is also the
standard color space for Exif. SRGB is recommended for regular images
and images you intend to publish on the Internet.

Adobe RGB is used for commercial printing and has a larger color range
than sRGB. Its wider range of colors helps you to easily edit photos on a
computer. Note that individual programs are generally compatible with a
limited number of color spaces. If you open an image in a program that
is not compatible with the image’s color space, the colors will appear
lighter.

:gas:; LU In Shooting mode, press [Fn] » Color Space P an option.

Adobe RGB

sRGB



Shooting Functions

Learn how to adjust the camera’s focus according to the subjects. SI ng |e AF

You can select a focusing mode appropriate to the subject among Single AF is appropriate for shooting a still subject. When you press
Single Auto Focus, Continuous Auto Focus, and Manual Focus. The AF [Shutter] halfway, the focus fixes in the focus area. The area turns green
function is activated when you press [Shutter] halfway. In the MF mode, when the focus is achieved.

you have to rotate the focus ring on the lens to focus manually.

In most cases, you can have a focus by selecting Single AF. Fast
moving subjects or subjects of a color similar to the background
are difficult to focus. Select an appropriate focusing mode for such
instances.

If your lens has an AF/MF switch, set the switch to MF to adjust the
focus manually.

When your lens has no AF/MF switch, press [AF-MF] to select a desired
AF mode.

JOSEEIE Ao In Shooting mode, press [AF-MF] »> an option.
focus mode,




Shooting Functions > AF mode

Continuous AF Manual focus

While you are pressing [Shutter] halfway, the camera continues to You can manually focus on a subject by rotating the focus ring on the
automatic focusing. Once the focus area is fixed on the subject, lens. The MF Assist function lets you easily achieve a focus. While

the subject is always in focus even when moving. This mode is you are rotating the focus ring, the focus area is magnified or the
recommended for shooting a person on a bicycle, a running dog, or a focus aid bar appears to help you achieve a clear focus. This mode is
car racing scene. recommended for shooting an object similar in color to the background,

a night scene, or fireworks.

e




Shooting Functions

The AF area function changes the positions of the focus area. Seleotion AF

Generally, cameras focus on the nearest subject. When there are a lot You can set the focus on an area you want. Apply an out-of-focus effect
of subjects, however, unwanted subjects can be in focus. In order to to make the subject more distinguishable.

prevent unwanted subjects from being in focus, change the focus area

so that a desired subject is in focus. You can get a clearer and sharper The focus on the photo below was repositioned and resized so that it
photo by selecting an appropriate focus area. fits the subject’s face.

To set the auto : :
In Shooting mode, press [Fn] »> AF Area B> an option.

E AF Zoom E Move

To resize or move the focus area, in Shooting mode, press [%f]. Use the
/ navigation button to move the focus area. Scroll the jog dial to resize the
focus area.



Shooting Functions > AF area

Multi AF Face detection AF
The camera displays a green rectangle in places where focus is set The camera focuses on human faces preferentially. Faces of up to 10
correctly. The photo is divided into two or more areas, and the camera people can be detected. This setting is recommended for shooting a
obtains focus points of each area. It is recommended for scenery group of people.
photos.

When you press [Shutter] halfway, the camera focuses on faces as
When you press [Shutter], the camera displays the focus areas in green shown in the photo below. In cases of shooting a group of people, the
as shown in the photo below. camera displays the focus on the nearest person’s face in white and the

rest of the people’s faces in gray.




Shooting Functions > AF area

Self-portrait AF

It can be difficult to check whether your face is in focus when you are
taking a self-portrait. When this function is on, the focus distance is set
to close-up and the beep from the camera gets faster when in focus.




Shooting Functions

The camera captures a photo only if the focus is set correctly when you
press [Shutter].

Turn on this function to always get a properly focused photo. Turn it off
to capture a photo regardless of focus.

To set the focus In Shooting mode, press [MENU] » (3). »> AF Priority »
priority, an option.




Shooting Functions

In the manual focus (MF) mode, you have to rotate the focus ring on
the lens to focus manually. When you set the MF Assist function, you
can achieve a clearer focus. This function is only available on a lens that
supports manual focus.

To set the manual In Shooting mode, press [MENU] P> (9. or €9, » MF
focus assist, Assist P> an option.

* Default

(Option —Descrpon

Off Do not use the function.
The focus area is magnified when you rotate the focus ring.
Enlarge*
The focus aid bar rises as the focus improves, when you
rotate the focus ring.
FA

A




Shooting Functions

You can set the shooting method such as Continuous, Burst, Timer and CO ntinuous
so on.

Continuously capture photos while you are pressing [Shutter]. You can
Select Single to capture one photo at a time. Select Continuous or capture up to 3 photos per second.

Burst to shoot fast moving subjects. Select AE BKT, WB BKT or
P Wiz BKT to adjust exposure, White Balance, or apply Picture Wizard
effects. You can also select Timer to capture a photo of yourself.

To set the shooting method, In Shooting mode, press @] B> an option.

Single

Capture one photo whenever you press [Shutter]. Recommended for
general conditions.




shooting Functions > Drive (Shooting method)

Burst Timer
Consecutively capture up to 10 shots per second (3 seconds), 15 shots Capture a photo with a delay of 2 to 30 seconds. The delay is
per second (2 seconds), or 30 shots per second (1 second) when you adjustable in increments of 1 second.

press [Shutter] once. Recommended for shooting the rapid motion of
fast moving subjects such as racing cars.

£ &£ % & ¢

/ To set the number of shots, in Shooting mode, press @] B Burst, and
then press [AF-MF]. / To set the delay, in Shooting mode, press )] » Timer, and
then press [AF-MF].



shooting Functions > Drive (Shooting method)

Auto Exposure Bracketing (AE BKT) White Balance Bracketing (WB BKT)

When you press [Shutter], the camera captures 3 consecutive When you press [Shutter], the camera captures 3 consecutive photos:
photos: the original, one a step darker, and one a step lighter. Use a the original and two more with different White Balance settings. The
tripod to prevent blurry photos as the camera captures three photos original photo is captured when you press [Shutter]. The other two are
continuously. You can adjust the settings in BKT Set menu. automatically adjusted according to the White Balance you have set.

You can adjust the settings in BKT Set menu.

Exposure -2

Exposure +2
Original WB-2

WB+2
Original



shooting Functions > Drive (Shooting method)

Picture Wizard Bracketing (P Wiz BKT) Bracketing setting

When you press [Shutter], the camera captures three consecutive You can set up the options for AE BKT, WB BKT, P Wiz BKT.
photos, each with a different Picture Wizard setting. The camera

captures a photo and applies the three Picture Wizard options you have To seta In Shooting mode, press [MENU] > (3)s P> BKT Set P
set to the image captured. You can select three different settings in BKT bracketing option, EEEKesli}N

Set menu.

Opion ————Dosorpion

Set the order and the area of bracket.

* BKT Order: Set the order in which the camera
captures the original, lighter, and darker photo
(represented by O, +, and -).

* BKT Area: Set the exposure range of the
3 AE BKT shots.

Adjust the White Balance interval range of the
Standard 3 WB BKT shots.

WB BKT Set For example, AB-/+3 adjusts the Amber value plus
or minus three steps. MG-/+3 adjusts the Magenta
value the same amount.

AE BKT Set

Vivid Retro

Select 3 Picture Wizard settings the camera uses

P Wiz BKT Set to capture the 3 P Wiz BKT photos.




Shooting Functions

In order to capture a realistic photo of a subject, the amount of light
should be constant. When the light source varies, you can use a flash
and supply a constant amount of light. Select appropriate settings
according to a light source and a subject.

To set flash options, In Shooting mode, press [Fn] » Flash P> an option.

Flash options

@ Off: Do not use the flash.

Option

¥

Description

1st Curtain: The flash fires
immediately after the shutter
opens. The camera captures a
photo of a subject earlier in an
action sequence clearly.

<

Ball moving directi

Option ‘ Description

%

2nd Curtain: The flash fires just
before the shutter closes. The
camera captures a photo of a
subject later in an action sequence
clearly.

Smart Flash: The camera automatically adjusts the brightness
of the flash according to the amount of light in the surrounding
environment.

SMART

Auto + Red: The flash automatically fires and prevents red-eyes.

iA Auto: The flash automatically fires in dark places.
@®
i Fill in: The flash fires whenever you capture a photo.

% Fill-in Red: The flash fires whenever you capture a photo and
®
prevents red-eyes.

s
AN\

* The available options may differ depending on the shooting mode.
* There is an interval between two bursts of the flash. Do not move until
theflash fires a second time.

Use only Samsung-approved flashes. Using incompatible flashes may
damage your camera.



Shooting Functions > Flash

Correcting the red-eye effect Using the built-in flash
If the flash fires when you capture a photo of a person in the dark, a red To open the built-in flash, press the flash pop-up button. The flash does
glow may appear in the eyes. To prevent this, select Fill-in Red. not fire when the built-in flash is closed, but automatically pops up and

fires in €swarr, SCENE modes.

Without red-eye correction With red-eye correction




Shooting Functions > Flash

Adjusting the flash intensity

Adjust the flash intensity to avoid overexposure or underexposure. You
can adjust it by + 2 levels.

To set the flash In Shooting mode, press [Fn] B> Flash »> an option »
intensity, [AF-MF] » scroll the jog dial or press [E=)/WB].

NOF

jmeENu: Back =@ Reset




Shooting Functions

The metering mode refers to the way in which a camera measures the
quantity of light.

The camera measures the amount of light in a scene, and in many of its
modes, uses the measurement to adjust various settings. For example,
if a subject looks darker than its actual color, the camera captures an
overexposed photo of it. If a subject looks lighter than its actual color,
the camera captures an underexposed photo of it.

The brightness and overall mood of the photo can also be affected by
how the camera measures the amount of light. Select an appropriate
setting for a shooting condition.

To set a metering option, In Shooting mode, press [ES]] P> an option.

Spot

The Spot mode calculates the amount of light in the center. When you
capture a photo in conditions where there is a strong backlight behind
a subject, the camera adjusts the exposure so as to shoot a subject
correctly. For example, when you select the Multi mode in a strong
backlight condition, the camera calculates that the overall amount of
light is abundant, which results in a darker photo. The Spot mode can
prevent this situation as it calculates the amount of light in a designated
area.

The subject is in bright color while the background is dark. The Spot
mode is recommended for a situation like this where a huge difference in
the exposure exists between a subject and a background.

Measuring the exposure value of the focus area

When this function is turned on, the camera automatically sets an
optimal exposure by calculating the brightness of the focus area. This
function is only available when you select either Spot metering or Multi
metering, and Selection AF.

To set this In Shooting mode, press [MENU] »> (&)s » Link AE to AF
function, Point »> an option.



Shooting Functions > IMIetering

Center-weighted Multi

The Center-weighted mode calculates a broader area than the Spot The Multi mode calculates the amount of light in multiple areas. When
mode does. It sums up the amount of light in the center portion of light is sufficient or insufficient, the camera adjusts the exposure by
the shot (60 ~ 80%) and that of the rest of the shot (20 ~ 40%). It averaging the overall brightness of the scene. This mode is suitable for
is recommended for situations where there is a slight difference in general photos.

brightness between a subject and a background or an area of the
subject is large compared to the overall composition of the photo.




Shooting Functions

This function automatically corrects the loss of bright detail that can
occur due to shading differences in the photo.

Without Smart Range effect With Smart Range effect

In Shooting mode, press [Fn] »> Smart Range »
an option.

To set Smart
Range options,




Shooting Functions

Use the Optical Image Stabilization (OIS) function to minimize camera
shake. OIS may not be available with some lenses.

Came shake tends to occur in dark places or when shooting indoors. In
such cases, the camera uses slower shutter speeds in order to increase
the amount of light taken in, which can result in a blurry photo. You can

prevent this situation by using the OIS function.

If your lens has an OIS switch, you have to turn the switch to use the
OIS function.

To set OIS . :
In Shooting mode, press [Fn] » OIS P> an option.

OIS options

Option | Description

i Mode 1: The OIS function is applied only when you press
osk | [Shutter] in full or half,
o Mode 2: The OIS function is on.

W

Off: The OIS function is always off. (This option may not be
available with some lenses.)

Without OIS correction With OIS correction



Shooting Functions

The camera automatically sets the exposure by measuring the levels

of light from the photo’s composition and the position of a subject. If
the exposure set by the camera is higher or lower than you expected,
you can adjust the exposure value manually. The exposure value is
adjustable in +3 increments. The camera displays the exposure warning
in red for each step beyond +3 range.

To adjust the exposure value, hold down [E4] and scroll left or right on
the jog dial. Original

You can check the exposure value by the position of the exposure level

indicator.
EV step
Exposure warnin Standard exposure index . . . .
J I You can set the size of the exposure adjustment in fractions of steps.
= ¢ + 1/3 step is more subtle than 1/2 step.
3 2 32101 2 3
Loalaa PR IV B PR BT B | Exposure level
A indicator - :
P N To set the size of the In Shooting mode, press [MENU] »> &; B> EV Step P
« v exposure adjustment, an option.
Decreased exposure Increased exposure
(darker) (brighter)

Option_ Description |

1/3 Set the size of the exposure adjustment by 1/3 step.

1/2 Set the size of the exposure adjustment by 1/2 step.




Shooting Functions

When you cannot achieve an appropriate exposure because of a strong
color contrast or you want to capture a photo on which the subject is
out of the auto focus area, lock the focus or exposure and then capture
a photo.

After locking the exposure or focus, aim the lens where you desire, and
press [Shutter].

You can change the function assigned to the button to focus lock, or both of
/ them. A function executed by half-pressing [Shutter] varies according to the

To lock the exposure or focus, adjust the photo’s composition on which function assigned to [AEL]. (p. 94)

you want to focus or calculate the exposure, and then press [AEL].



Shooting Functions

The functions available for video are explained below. Fader

You can fade in or fade out a scene using the fader function on the
camera without having to do it on a PC. Use the function appropriately

Movie AE mode and add dramatic effects on your videos.

Set the aperture value for shooting a movie.
To set fader ; ’
aptions, In Shooting mode, press [Fn] »> Fader »> an option.

To set movie In Shooting mode, press [Fn] » Movie AE Mode »
aperture options, an option.
Option | Description
GBI ‘ Eeree o Pm. | Off: Fader function not used.

P Program: The aperture value is adjusted automatically. In: Scene gradually fades in.

Out: Scene gradually fades out.

A Aperture Priority: Set the aperture value manually before
recording a video. Scroll the jog dial to adjust the aperture value. In-out: The fader function is applied at the start and end of the

scene.

HHA




Shooting Functions > Video functions

Wind cut Voice
When you record videos in noisy environments, unintended sounds Sometimes, a muted video is more appealing than the one with sound.
can be recorded in videos. In particular, severe wind noise recorded Turn the voice off to record a muted video.

in videos distracts you from enjoying your videos. Use the Wind Cut

function to remove some surrounding noise in addition to wind noise. :
To set voice ; . .
. In Shooting mode, press [Fn] » Voice » an option.
options,
To set Wind Cut In Shooting mode, press [MENU] » €9, » Wind Cut
options, P an option.

Auto focus

While shooting a video, press [Depth Preview] to activate or deactivate
the AF function. This function may not work depending on the lens you
are using.




Playback/Editing

Learn about how to play back and edit photos and videos.
Refer to chapter 5 for editing files on a PC.



Playback/Editing

Learn how to search photos and videos quickly through the thumbnail VIGWIﬂg image thu mbnai |S
view and to protect and delete files.

In order to search for photos and videos you want, convert to the
thumbnail view. The thumbnail view displays multiple images at a time
. . so that you can easily look through items you wish to find. You can
Viewi ng phOtOS also classify and display files by their type, day recorded, and week

recorded.
1 Press [®]].
 The most recent file you captured will be displayed.

2 Scroll the jog dial or press [[E&)/WB] to scroll through files.

& on 100-0001
London

i P18
Filter 2011.01.01

(

Press [®)] to display 9 or 20 thumbnails.
Press [(®) to return to the previous mode.

P /40 F35 ez DOOO 1/0 1000 6@

@O

V-



Piayback/Editing > S€Arching and managing files

Viewing files by category in Smart Album Protecting files

1 In the thumbnail view. press [MENU]. Protect your files from accidental deletion.
C Select a category, and then press []. In Playback mode, select a file, and then press [omn].
 founprotectine fle, press om) agan
Tvoe View files by the file type such as photo, video, or
yp photo with a voice memo.
Date View files by the date they were saved. Deleti ng files
Week View files by the week they were saved. Delete files in Playback mode and secure more space on your memory
View file by the place they were saved. (Only the card. Protected files are not deleted.
Location photos captured with a GPS module have the
location information.)
Deleting a single file
: 0K
3 Select an option, and then press [F]. You can select a single file and delete it.

1 In playback mode, select a file and press [ ].

Z When the pop-up message appears, select Yes.



Piayback/Editing > S€Arching and managing files

Deleting multiple files Deleting all files

You can select multiple files and delete them. You can delete all files on the memory card at once.
1 In Playback mode, press [4] » Multiple Delete. | In Playback mode, press [MENU].
« Alternatively, in Playback mode, press [MENU] » =» Delete »
Select. C Select 3 » Delete » All.
C Select files you want to delete by pressing [[E8)/WB], and 3 When the pop-up message appears, select Yes.

0K
then press [5].
* Press [] again to cancel your selection.

3 Press[%].

Y When the pop-up message appears, select Yes.



Playback/Editing

Enlarging a photo Viewing a slide show
You can enlarge photos when viewing them in Playback mode. You can You can view photos in a slide show, apply various effects to the slide
also use the Trim function to extract the portion of the image displayed show, and play background music.

on the screen and save it as a new file.

1 In Playback mode, press [MENU].

Magnified area

Magnification (the maximum
magnification may differ by E Select @

resolution)

3 Select a slide show effect option.
- Skip to step 4 to start a slide show with no effects.

(Option ———Desorpion

Set the photos you want to view as a slide show.
All: View all photos in a slide show.

v Fulllmage s Trim Date: View photos captured on a specific date in a
Images slide show.
a Select: View selected photos in a slide show.
@ In Playback mode, press [®)] to enlarge a photo. Sl%undhpicture: View voice recorded photos in a
Q= Press [®)] to reduce a photo. sliae show.
Effect Select a transition effect.
Select Off for no effects.
To | Do this
g Select th t of ti h photo is displayed.
Move magnified area Press [AF-MF, IS0, &S, WB]. Interval elect the amount ot time each photo IS dispiaye
. . Musi Play back d ic.
Crop the enlarged image Press [Fn]. (saved as a new file) usic ay background music
Return to the original image Press ].

Y Select Slide Show » Play.
« Slide show begins right away.



Playback/Ediing > ViEWING photos

Highlight Auto rotating
This function identifies the parts of a photo that are excessively bright. With Auto Rotate on, the camera automatically rotates photos you have
When you view a photo with highlight on, the excessively bright areas of captured vertically so they fit the screen horizontally.

the photo blink in blue.

To set auto rotate In Playback mode, press [MENU] » (X » Auto Rotate P
options, an option.

Original Highlighted

To set highlight In Playback mode, press [MENU] » = B> Highlight »
options, an option.




Playback/Editing

You can play a video, capture an image from a video, or crop a video.

» PLAY i

100-0002

wwme  om o

ok Pause

{04 Stop

Video viewing controls
o Doths

Rewind

Press [EF)].
Scan backward in 2X, 4X, and 8X increments
each time you press [[E3)].

Pause/Play

Press [].

Fast forward

Press [WB].
Scan forward in 2X, 4X, and 8X increments each
time you press [WB].

Volume control

Scroll the jog dial to the left or right.

Stop

Press [AF-MF].

Trimming a video during playback

1

Press [] at the point where you want the new video to
begin.

2 When paused, press [®)].

3 Press [] at the point where you want the new video to

end.

Y When paused, press [@)].

5 When the pop-up message appears, select Yes.

u The cut file is saved as a separate file under a new name.



Playback/Editing > Playing videos

Capturing an image during playback

1 Press [X] at the point where you want to save a stil
image.

C Press [ISO].

/ * The resolution of the captured image is the same as the video resolution.
¢ The captured file is saved as a separate file under a new name.

N:



Playback/Editing

Perform photo editing tasks, such as resizing, rotating, eliminating * Default

red-eye effects, and adjusting brightness, contrast, or saturation. lcon | Descripion |

Edited phO’[OS are saved as new files under different file names. Smart Filter: App|y various filter effects to photos and create

unique images.
To set Image Edit options, In Playback mode, press [Fn] P> an option.

i +
Options (a: 3
* Default
(G Red-eye Fix: Remove red-eyes on a photo. (Off*, On) - g

Miniature Fish-Eye

Defog Halftone Dots Soft Focus

Backlight: Correct the brightness of an underexposed photo.
(Off*, On)

u The new file may be smaller than the original.

A
OFF

Before correction After correction




Playback/Editing > EAiting photos

* Default

Icon Description

o)

Photo Style Selector: Apply various photo styles to photos.

| 1 _, e B T PR . ot ] '|-'|l.'. i 2l

Classic

Gloomy

Resize: Resize the size of a photo. (Off*, 10M, 6M, 2M)

/ The available resolutions may differ depending on the size of the
selected photo.

* Default

Icon Description

Rotate: Rotate a photo. (Off*, Right 90°, Left 90°, 180°,
Horizontal, Vertical)

n The new file may be smaller than the original.

Face Retouch: Hide facial imperfections. (Off*, Level 1,
Level 2, Level 3)

&

+
&2
-\




Camera settings menu

Learn about the user settings and general settings menu.
You can adjust the settings to better suit your needs and preferences.



Camera settings menu

You can set the user environment with these settings. Auto ISO range

You can set the maximum ISO value under which each EV step is
In Shooting mode, press [MENU] P> 8 P> an option. chosen when you set the ISO Auto.

* Default

Option ‘ Value

1 Step ISO 200, ISO 400, ISO 800*, ISO 1600
EV step ISO 125, 1SO 160, 1SO 200, ISO 250, ISO 320,
, . . . 1/3 Step ISO 400, 1SO 500, ISO 640, ISO 800*, ISO 1000,
You can set the size of the exposure adjustment in fractions of steps. ISO 1250, 1SO 1600
1/3 step is more subtle than 1 step.
ISO custimizing Noise reduction

Use the Noise Reduction to reduce the visual noise in photos.

* Default

. e . (0]4]1] D ipti
You can set the size for the ISO sensitivity by either 1/3 or 1 step.

High ISO NR

This function reduces noise that may occur when
you set a high ISO sensitivity. (Off, On*)

Long Term NR

This function reduces noise when you set the
camera for a long exposure (over 1 second).
(Off, On*)




Camera settings menu > USer settings

AF assist light

When shooting in dark places, turn the AF assist light on in order to
have a better auto focus. The Auto Focus functions more accurately in
dark places when the AF assist light is on.

User display

You can add or remove shooting information from the display.

2011.01.01
ndon

=

....................

* Default

o Dosorpion

1 Icons
Set the shooting options icons on the display on or off.
2 Grid Line
Set the grid on the display on or off. (Off*, 2 X 2, 3 X 3, +, X)
Histogram
Set the histogram on the display on or off.
About histogram
A histogram is a graph that shows the brightness distribution of
a photo. A histogram inclined to the left indicates a dark photo.
A histogram inclined to the right indicates a bright photo. The
3 height of the graph is related to color information. The graph

gets higher if a specific color is more common.

Insufficient exposure

Balanced exposure

Excessive exposure




Camera settings menu > USer settings

Key mapping

You can change the function assigned to the AEL and Preview buttons.

* Default

You can set the AEL button’s function. The AEL and

AFL functions save the exposure value or focus area

respectively when a photo is captured.

You can choose among three settings for the AEL button:

* AEL*, which executes the auto exposure lock function.

When AEL is on, half-pressing [Shutter] executes the

AEL .
auto focus lock function.

* AFL, which executes the auto focus lock function.
When AFL is on, half-pressing [Shutter] executes the
auto exposure lock function.

* AEL + AFL, which executes the auto exposure and
focus lock functions together.

You can assign one of the following functions to the

Depth Preview button:

* One Touch WB (White Balance), which executes the
Custom White Balance function.

» Optical Preview*, which executes the Depth of Field
Preview function for the current aperture value. (p. 20)

* One Touch RAW+, which activates or deactivates the
RAW+JPEG feature.

Preview




Camera settings menu

Learn about the menu items of the Setting 1.

To set Setting 1 . :
In Shooting mode, press [MENU] B> €531 B> an option.

* Default

Item ‘ Description

File Name

Set the method of creating file names.
» Standard™: SAM_XXXX.JPG(sRGB)/

_SAMXXXX.JPG(Adobe RGB)

e Date:

- sRGB files - MMDDxxxx.JPG. For example, for a photo
captured on Jan. 01, the file name would be 0101 xxxx.
Pg-

- AdobeRGB files - MDDxxxx.JPG for the months Jan
through Sept. For the months Oct through Dec, the
month number is replaced by the letters A (Oct.), B
(Nov.) and C (Dec.).

For example, for a photo captured on Feb. 03, the file
name would be 203xxxx.jpg. For a photo captured on
Oct. 05, the file name would be A05xxxx.jpg.

* Default

File Number

Set the method of numbering files and folders.

» Series™: New file numbers continue the existing number
sequence, even if you have installed a new memory
card, formatted the card, or deleted all photos.

* Reset: After using the reset function, the next file name
is started at 0001.

selected the sRGB color space and Standard file
naming, the first file name is SAM_0001.

¢ File name numbers are increased by 1 from
SAM_0001 to SAM_9999.

¢ Folder numbers are increased by 1 from 100PHOTO
to 999PHQOTO.

¢ The maximum number of files that can be saved in
one folder is 9999.

¢ File numbers are assigned according to DCF (Design
rule for Camera File system) specifications.

¢ If you change a file name (for example, on a
computer), the camera will not be able to play the file.

a * The first folder name is 100PHOTO, if you have

Folder Type

Set the type of folder.
» Standard*: XXXPHOTO
» Date: XXX_MMDD

Language

Set a language the camera shows on the display.




Camera settings menu > S€ttiNg 1

* Default

rom " pesorpion

Format the memory card. Formatting prepares a memory
card for use in the camera and deletes all existing files
including protected files. (No, Yes)

Format Errors can occur if you use a memory card formatted

/ by another brand of camera, a memory card reader, or
a computer. Please format memory cards in the camera
before using them to capture photos.

Reset the setup menu and shooting options to the factory
Reset defaults. (Date, time, language, and video output settings
do not change.) (No, Yes)
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Camera settings menu

Learn about the menu items of the Setting 2. * Default
To set Setting 2 , . Set power shut off time. The camera shuts off if you do
In Shooting mode, press [MENU] P> ¢S32 B> an option. not use it for the time you set. (0.5 min, 1 min*, 3 min,
5 min, 10 min, 30 min)
o " Default Power Save / * The camera retains the power-off time setting even if
ltem ‘ Description you replace the battery.
Set the Quick View time length — the amount of time the ‘ tPower Savetma%’\?m WO,”; i th? cvameral}z COE”eCted
Quickview camera displays a photo immediately after you captured n?o?/i((;eompu ef, TV, or printer, piaying & siide show or
it. (Off, 1 sec*, 3 sec, 5 sec, Hold) ’
Adjust the display brightness, auto brightness setting, or Set date, time, date format, time zone and whether to
display color. imprint the date on photos. (Type, Date, Time Zone,
 Display Brightness: You can adjust the display Time, Imprint)
Display brightness by using [AF-MF/IS0]. Date & Time
Adjust * Auto Brightness: Turn auto brightness on or off. / * The date appears on the lower right side of the photo.
(Off, On*) * When you print a photo, some printers may not print
* Display Color: You can adjust the display color by the date appropriately.
using [AF-MF/ISO/ES)/WB].
Set the display off time. The display turns off if you do not : Systgmf\flolt:_m(le: Sg;fthl_e Sou&d ZP'UT‘G:T t#rn al
Display Save | use the camera for the time you set. (Off, 0.5 min*, sound off entirely. (Off, Low, Medium”, High)
1 min, 3 min, 5 min, 10 min) Sound * AF Sound: Set the sound the camera makes in AF

mode on or off. (Off, On*)
* Button Sound: Set the sound the camera makes when
you press buttons on or off. (Off, On*)




Camera settings menu

Learn about the menu items of the Setting 3.

To set Setting 3 . .
In Shooting mode, press [MENU] B> ¢S5 B> an option.

* Default

Item ‘ Description

You can set how the camera display and viewfinder

function.
Display * Auto Select”: Set the proximity sensor to automatically
Select select the display or viewfinder.

* Main Display: Set to use the display.
* EVF: Set to use the viewfinder.

* Sensor Cleaning: Remove dust from the sensor.
 Start-Up Action: When on, the camera performs
sensor cleaning each time you turn it on. (Off*, On)

Sensor / As this product uses interchangeable lenses, the sensor
Cleaning can get dust on it when you change lenses. This can

lead to dust particles appearing in the photos you
capture. It is recommended not to change lenses when
you are in a particularly dusty area. Also, make sure to
attach the lens cap to the lens when not using it.

* Default

Video Out

Set the video signal output appropriate for your country

when connecting the camera to an external video device

such as a monitor or TV.

* NTSC*: USA, Canada, Japan, Korea, Taiwan, Mexico

* PAL (Supports only PAL B, D, G, H, or I):Australia,
Austria, Belgium, China, Denmark, Finland, Germany,
England, Italy, Kuwait, Malaysia, New Zealand,
Singapore, Spain, Sweden, Switzerland, Thailand,
Norway

Anynet+
(HDMI-CEC)

When you connect the camera to an HDTV that supports

Anynet+ (HDMI-CEC), you can control the play function of

the camera with the TV remote control.

* Off: You cannot control the play function of camera
with the TV remote control.

* On*: You can control the play function of camera with
the TV remote control.

HDMI Size

When you connect the camera to an HDTV with an HDMI
cable, you can change the resolution of the image.

* NTSC: Auto*, 1080i, 720p, 480p

* PAL: Auto*, 1080i, 720p, 576p

you select, the camera sets the resolution one level

a If the connected HDTV does not support the resolution
lower.




Camera settings menu > S€ttiNG 3

* Default

om " pesorpion

Firmware
Update

Display the firmware version of the camera body and
lens, and update the firmware.

* Body Firmware: Display and update the firmware of
the camera body.

* Lens Firmware: Display and update the firmware of the

lens.

v

You can download firmware upgrades from
WWW.Samsung.com.

You cannot run a firmware upgrade without a fully
charged the battery. Recharge the battery fully before
running a firmware upgrade or attach an optional
adapter to provide power.

If you update the firmware, user settings values will
be reset. (Date, time, language, video out will not
change.)

Do not turn the camera off while the update is in
progress.



www.samsung.com

Camera settings menu

Learn about the menu items of the Setting 4. You should purchase an
optional GPS accessory in order to use the GPS function.

GeoTagging

To set Setting 4 . .
In Shooting mode, press [MENU] > ¢S4 B> an option.

* Default

Set to capture photos with location information
using the Global Positioning System (GPS). Location
information is added to the Exif data associated with
the photo. (Off, On*)

GPS Valid Time
Settings

Set the time to use the last location information when
the camera fails to receive GPS signals. If the camera
fails to receive GPS signals after the specified time,
the location information will not be recorded onto the
photos. (15 sec*, 30 sec, 1 min, 3 min, 10 min,

30 min)

Location
Display

Set to display the location information on the top right
screen of Shooting mode. The location information
will appear in Korean only when you are in Korea and
the display language is set to Korean. When another
language is set, the location information will appear in
English. (Off, On*)

GPS Reset

Set to search for GPS satellites closest to your current
position. (No, Yes)
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Camera settings menu

Learn about the menu items of the Setting 5.

To set Setting 5 . :
In Shooting mode, press [MENU] B> % B> an option.

* Default

ltem ‘ Description

Distortion
Correct

Correct lens distortion that might occur from lenses.
This feature may not be available with some lenses.
(Off*, On)

Lens i-Function

Set the functions to be adjustable when you press
[iFn] on an iFn lens.
* WB: Set White Balance to be adjustable. (Off, On*)
* ISO: Set the ISO sensitivity to be adjustable.

(Off, On*)




Connecting to external devices

Make full use of the camera by connecting it to external devices such as a computer, TV, or photo printer.



Connecting to external devices

Play back photos or videos by connecting your camera to a TV using
the A/V cable.

Viewing files on a TV

1 In Shooting or Playback mode, press [MENU] » {53 »
Video Out.

C Select a video signal output according to your country or
region. (sf. 98)

3 Connect the TV and the camera using the A/V cable.

Video Audio

LA 9 ¢

Y Make sure the TV and the camera are turned on and then
select the video input mode or source (AV or AV1 for
example) of the TV.

5 View the videos and photos using the buttons on the
camera.

2

* Depending on the TV model, you may see some digital noise or part of an
image may not appear.

* Images may not be centered on the TV screen depending on your TV
settings.

* You cannot capture photos or videos while the camera is connected to a
TV.



Connecting to external devices > Viewing files on a TV or HDTV

Viewing files on an HDTV

| In Shooting or Playback mode, press [MENU] » 535 »
HDMI Size » an option.

C Connect the HDTV and the camera using the HDMI cable.

/ If both A’V and HDMI cables are connected at the same time, the HDMI
cable has the priority. Disconnect the A/V cable for better playback.

3 Make sure that the HDTV and camera are turned on, and
then select the HDMI mode.

« The HDTV screen mirrors the camera's display.

Y View the videos and photos using the buttons on the
camera.

using the Anynet+(CEC) method.

The Anynet+(CEC) functions allow you to control connected devices using

the TV remote control.

* |f the HDTV supports Anynet+(CEC), the TV turns on automatically when
used in conjunction with the camera. This feature may not be available on
some HDTVs.

* When connected to an HDTV by an HDMI cable, the camera cannot
capture a photo or video.

* When connected to an HDTV, some of the camera’s playback functions
may not be available.

* The length of time after which the camera and an HDTV are connected
may vary depending on the SD card that you are using.

* As the main feature of an SD card is to increase the transfer speed, it is not
necessarily true to say that an SD card with a faster transfer speed is also
fast in using the HDMI function.

a * When using the HDMI cable, you can connect the camera to an HDTV



Connecting to external devices

Print photos on your camera by connecting to printers directly or saving 2 Turnon your camera.

Digital Print Order Format (DPOF) information on a memory card. « When the pop-up message appears on the camera display,

select Printer.

/ If your printer has the mass storage feature, you must first set the USB
mode to Printer in the settings menu.

Printing photos with a PictBridge photo

printer

You can print photos with a PictBridge-compatible printer by connecting 3 Press [ES)/WB] to select a photo.
your camera directly to the printer. - Press [MENU] to set printing options.
| With the printer on, connect your camera to the printer Y Press [] to print.

with the USB cable.




Connecting to external devices > Printing photos

Creating a print order (DPOF)

DPOF (Digital Print Order Format) lets you set the print size of a photo
and the number of copies to be printed. The camera saves the DPOF
Sz AN information in the MISC folder of your memory card. Your camera
displays a DPOF indicator when it displays an image with DPOF

Ii

ey Auto information. If you have set DPOF information for your images, you can
Type Auto take the memory card to a digital printing shop for printing.
Quality Auto

Date Auto To set DPOF In Playback mode, press [MENU] » X » DPOF »
B Print JMENUS Exit options, select an item.

Option ‘ Description

Images Select whether to print the current photo or all
photos.

Size Specify the size of the print.

Layout Set the number of photos per page.

Type Select the type of paper.

Quality Set the print quality.

Date Set to print the date.

File Name Set to print the file name.

Reset Reset setting to their default values.

a Some options may not be supported by some printers.



Connecting to external devices > Printing photos

DPOF options
Opton ——_ Doserption |

You can select photos to print and the number of copies

for photos.

e Select: Select the number of copies for photos you
select. (Select photos you want to print B Select the
number of copies by scrolling the jog dial left or right,
and then pressing [Fn].)

* All: Select the number of copies for all photos. (Select
the number of copies by pressing [AF-MF/IS0], and
then pressing [].)

* Reset: Cancel all DPOF printing quantity selections.

Standard

This option lets you print all photos set to be printed as
Index thumbnails in a single paper. The print size that you have
set is available only with DPOF 1.1-compatible printers.

You can specify the size of the print.

» Select: Select the print size for photos you choose.
(Select photos you want to print B Select the print size
by scrolling the jog dial left or right, and then pressing

Size [Fn].)

* All: Select the print size of all the photos saved in
the memory card. (Select the print size by pressing
[AF-MF/ISQ], and then pressing [].)

* Reset: Cancel the DPOF print size for all photos.




Connecting to external devices

Transfer files on a memory card to your computer by connecting the
camera to the PC.

Transferring files to your Windows
computer

Connecting the camera as a removable disk

You can connect the camera to your computer as a removable disk.

3 Turn on the camera.

« When the pop-up message appears on the camera display,

select Computer.
1 Turn off the camera.

Y On your computer, select My Computer » Removable
2 Connect the camera to your computer with the USB Disk » DCIM » XXXPHOTO or XXX_MMDD.
cable.

¢ You must plug the end of the cable with the correct connection plug 5 Select the files you want, and then drag or save them to

into your camera. If the cable is reversed, it may damage your files. your computer.
The manufacturer is not responsible for any loss of data.

¢ If you try to plug the USB cable into the HDMI port, the camera may

not work properly. If it occurs, restart the camera. If the Folder Type is set to Date, the folder name appears as “XXX_MMDD”.
' / For example, if you capture a photo on January 1, the folder name will be

"101_0101".



Connecting to external devices > Transferring files to your computer

Disconnecting the camera (for Windows XP) Transferring files to your Mac Compu‘ter

With Windows Vista and Windows 7, the methods for disconnecting the

camera are similar 1 Turn off the camera.

| Ensure that no data is being transferred between the c Connect your camera to a Macintosh computer with the
camera and the computer. USB cable.
« If the status lamp on your camera is blinking, it means the data ,
transfer is in progress. Please wait until the status lamp stops J g Mac 0S 10.4 or later is supported.
blinking.
. . * You must plug the end of the cable with the correct connection plug
C Click ! on the tool bar at the bottom right of your & into your camera. If the cable is reversed, it may damage your files.
computer screen. The manufacturer is not responsible for any loss of data.
* |f you try to plug the USB cable into the HDMI port, the camera may
ﬁ.v' 2, :% E.: A 10000 &k not work properly. If it occurs, restart the camera.
3 Click the pop-up message. 3 Turn on the camera.
« When the pop-up message appears on the camera display,
Y Click the message box indicating safely removed. select Computer.
5 Remove the USB cable. Y Open the removable disk.

5 Transfer photos or videos to the computer.



Connecting to external devices

Digital photos can be edited in a variety of ways through image editing
programs. Learn to edit photos using the provided editing programs.

Installing software

Use the included software to transfer files from the camera to your PC.

You can also edit photos and upload them on web.

| Insert the CD-ROM into your PC.

£ When the setting wizard appears, click Samsung Digital
Camera Installer.

3 Select a program you want to install, and then click
Install.

Y Follow the on-screen instructions.

5 When the installation is complete click Exit.

Programs contained on the CD

Intelli-studio Edit photos and videos.

Convert RAW files into the desired file

Samsung RAW Converter format.

* |f your computer does not meet the requirements, videos may not play
/ correctly or it may take longer to edit videos.
* Install DirectX 9.0c or above before you use the program.

* You must use Windows XP/Vista/7 or Mac OS 10.4 or later to connect the
camera as a removable disk.

Using a self-assembled PC or a PC and OS that are not supported may void
your warranty.

Using Intelli-studio

Intelli-studio is a built-in program that allows you to play back and edit
files. You can also upload files to your favorite websites. For details,
select Help » Help in the program.



Connecting to external devices > EAiting photos on a PC

ReQU|rements * The requirements are recommendation only. [t may not work properly even
- / when the computer meets the requirements, depending on the condition of
fom [ Roqurements |

your computer.

0S Windows XP SP2, Windows Vista, or Windows 7 * Intelli-studio is compatible only with Windows.

(32-bit editions) * Intelli-studio supports the following formats:

Intel® Pentium® 4, 3.2GHz or higher/ - Videos: MP4 (Video: H.264, Audio: AAC), WMV (WMV 7/8/9),

CPU o : AVI (MJPEG)
AMD Athlon™ FX, 2.6GHz or higher - Photos: JPG, GIF. BMP, PNG, TIFF

RAM Minimum 512MB RAM * You cannot open the RAW format files with the Intelli-studio program.
(1GB or more recommended) * You cannot edit files directly on the camera. Transfer files to a folder on

Hard disk capacity | 250MB or more (1GB and above recommended) your computer before editing.

* CD-ROM drive

* 1024x768 pixels, 16-bit color display compatible
monitor (1280x1024 pixels, 32-bit color display
recommended)

* USB 2.0 port

* nVIDIA Geforce 7600GT or higher/
ATI X1600 series or higher

* Microsoft DirectX 9.0c or later

Others

* B4-bit editions of Windows XP, Windows Vista, and Windows 7 are not supported.



Connecting to external devices > EAiting photos on a PC

Using the Inteli-studio Interface L e —

Enlarge or reduce the thumbnails in the list.

7 | Select afile type.

8 View files of the selected folder on your computer.

9 Show or hide files of the connected camera.

# o Foldar

13 45 it
1 Face

10 | View files of the selected folder on the camera.

11 | View files as thumbnails or on a map.

@ My Compuing
o G
EaaD

12 | Browse folders in the connected device.

&2 Comneclid Device
= ﬂ'saénm Camara

13 | Browse folders in your computer.

30T
Iy MOPHOTO:

14 | Move to the previous or next folder.

15 Print files, view files on a map, store files in My Folder, or register

B Surs o File faces.
ﬂ 11

[\[o} Description

Open menus.

Display files in the selected folder.

Change to the Photo edit mode.

Change to the Video edit mode.

Change to the Sharing mode. (You can send files by email or
upload files to websites, such as Flickr or YouTube.)

O AN~




Connecting to external devices > EAiting photos on a PC

Transferring files using Intelli-studio 3 Run Intelli-studio on your computer.

You can easily transfer files on your camera to your computer by using l-I Turn on the camera

Intelli-studio.
« When the pop-up message appears on the camera display,
1 Turn off the camera. select Computer.
Z Connect the camera to your computer with the USB 5 Select a folder on your computer to save new files and
cable. select Yes.

» New files will be transferred to the computer.

« If your camera has no new files, the pop-up window for saving
new files will not appear.

* You must plug the end of the cable with the correct connection plug
A into your camera. If the cable is reversed, it may damage your files.
The manufacturer is not responsible for any loss of data.
¢ If you try to plug the USB cable into the HDMI port, the camera may
not work properly. If it occurs, restart the camera.



Connecting to external devices > EAiting photos on a PC

Using Samsung RAW Converter Requirements for Mac
Photos captured by a camera are often transformed to JPEG formats

and stored in the memory according to the settings of the camera at 0S Apple® Mac OS 10.4 /v10.5/v10.6
the time of shooting. RAW files are not transformed to JPEG formats cPU Intel processor-based or compatible computer
and are stored in the memory without any changes. With Samsung (Core 2 Quad or later recommended) / PowerPC
RAW Converter, you can calibrate exposures, White Balances, tones, RAM 1GB or more recommended
contrasts, and colors of photos.
Please reserve at least 100MB of space. Please
Hard disk capacit allocate sufficient disk space for image storage.
. . pactty (One image may use more than 10MB of disk
Requirements for Windows space.)
Others + XGA (1024768, Full Color 24 bt o ighe
Microsoft Windows XP, Windows Vista, or * Keyboard, mouse, or equivalent devices

Windows 7
0Ss * Administrator rights are needed for installation. .
* The program runs as a 32-bit application under the 64-bit / Samsung RAW Converter may not perform correctly on some computers,
0S. even when the computer meets the requirements.
; * The Mac installation program will not autorun. Please manually run the
Intel Pentium®, AMD Athlon processor-based PC or setup file on the provided CD-ROM.
compatible computer (Pentium4, Athlon XP or later
CPU recommended)

* Multi-core processor ready (Intel Core i7,Core 2 Quad, Core
2 Duo, AMD Phenom IIX4, Phenom X4, etc.)

RAM 1GB or more recommended

Please reserve at least 100MB of space. Please
allocate sufficient disk space for image storage.
(One image may use more than 10MB of disk
space.)

* XGA (1024x768), Full Color (24 bit or higher)
* Keyboard, mouse, or equivalent devices

Hard disk capacity

Others




Connecting to external devices > Eiting photos on a PC

Using the Samsung RAW Converter Interface Editing RAW format files

For details about using Samsung RAW Converter, click Help » If you edit the RAW format files with the Samsung RAW Converter,
Open software manual. you can maintain high image quality. You can also edit JPEG and TIFF
format files.
1
2 - -
To adjust the exposure of an image
3 1 Select File » Open file and open a file.
Z From the editing tools, select 4.
4

Menu
Toolbar

Editing tools

o Dosorpion
1

2

3

4

Open/Close the fine adjustment window for the editing tools.




Connecting to external devices > EAiting photos on a PC

3 Adjust the exposure with the scroll bar. To adjust the contrast of an image

| Select File » Open file and open a file.
2 From the editing tools, select @).

3 Adjust the tone with the scroll bar.

Original image Edited image
P Mode, Aperture: f=8,
Shutter Speed: 1/15 sec, ISO=100

Original image Edited image

Original image Edited image



Connecting to external devices > EAiting photos on a PC

To save RAW files in JPEG or TIFF formats

| Select File » Open file and open a file.
C Select File » Development.

3 Select a file format (JPEG or TIFF) and select Save.
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Appendix

When the following error messages appear, try these remedies.

Error messages ‘ Suggested remedies

The lens is locked. Rotate the lens counter-
clockwise until you hear a click. (p. 33)

Lens is locked

* Turn off your camera, and then turn it on again.
* Remove your memory card and insert it again.
* Format your memory card.

Card Error

Low Battery Insert a charged battery or recharge the battery.

Capture photos or insert a memory card that

No Image File contains photos.
File Error Delete the damaged file or contact a service center.
Memory Full Delete unnecessary files or insert a new memory

card.

You can lock SD or SDHC card to prevent files from
being deleted. Unlock the card when shooting.
(p- 122)

Card Locked

Folder and file
number are
maximum values.
Replace the card.

File names do not match the DCF standard. Transfer
the files on the memory card to your computer and
format the card. (p. 96)

Turn off your camera and remount the lens. If the

Error 00 message still appears, contact a service center.
Turn off your camera, remove the battery, and insert
Error 01/02 again. If the message still appears, contact a service

center.
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Appendix

Cleaning the camera

Depending on different shooting conditions, dust may appear in photos

because the image sensor is exposed to the external environment.
This problem is normal, and the exposure to dust occurs in everyday

Use a brush to remove dust and wipe the lens gently with a soft cloth. If use of the camera. You can remove dust from the sensor by operating

any dust remains, apply lens cleaning liquid to a piece of cleaning paper the sensor cleaning function. (p. 98) If dust remains after cleaning

and wipe gently. the sensor, contact a service center. Do not insert the blower into the

mounting opening of the lens.

Camera body

Wipe gently with a soft, dry cloth.

Never use benzene, thinners or alcohol to clean the device. These solutions
can damage the camera or cause it to malfunction.




appendix > Maintaining the camera

Using or storing the camera
 Avoid exposing the camera to very cold or very hot temperatures.

+ Avoid using your camera in areas with extremely high humidity, or
where the humidity changes drastically.

* Protect your camera and the display from impact, rough handling, and
excessive vibration to avoid serious damage.

» Do not store the camera where there are mothballs.

» Your camera is not waterproof. Do not handle the battery, adapter, or
memory card with wet hands. Operating the camera with wet hands
may cause damage to your camera.

* When you store the camera for an extended period, place it in a
sealed container with an absorbent material, such as silica gel.

* Remove the batteries from your camera when storing it for an
extended period. Installed batteries may leak or corrode over time and
cause serious damage to your camera.

« Turn off the camera while not in use.

« Your camera consists of delicate parts. Avoid impacts to the camera.

» Protect the display from external force by keeping it in the case when
not in use. Protect the camera from scratches by keeping it away from
sand, sharp implements, or loose change.

» The camera may turn off if impacted from the outside. This is to
protect the memory card. Turn on the camera to use it again.

* When you use the camera in low temperatures, it may take some time
to turn on, the color may be changed temporarily, or after-images may
appear. These conditions are not malfunctions and they will correct
themselves when the camera is returned to normal temperatures.



appendix > Maintaining the camera

About memory card Memory card capacity

The memory capacity may differ depending on shooting scenes or

Supported memory card shooting conditions. These capacities are based on a 1 GB SD card.
Your camera supports SD or SDHC memory cards. Size \ HQ ‘ Normal
1280 (16:9) | Approx. 15 min Approx. 22 min
Terminal—»ﬁﬂﬂﬂ["]m *Videos ] . :
[ (30 per sec) 640 (4:3) Approx. 44 min Approx. 66 min
! 320 (4:3) Approx. 145 min Approx. 210 min
Write-protect switch A

* The recordable time may vary if you use the zoom. Several videos were recorded in

succession to determine the total recording time.
Label (front) 9

You can prevent files from being deleted by using the write-protect
switch on an SD or SDHC card. Slide the switch down to lock or slide it
up to unlock. Unlock the card when capturing photos and videos.
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‘ Super Fine Normal RAW RAW + S.Fine| RAW + Fine RAW + Normal
14M 4592X3056 (3:2) 141 282 423 34 25 30 32
10M 3872X2592 (3:2) 195 391 587 - 28 34 35
6M 3008X2000 (3:2) 320 640 961 - 31 37 38
2M 1920X1280 (3:2) 732 1,465 2,198 - 35 42 42
Burst 1,161 2,322 3,484 - - - -
12M 4592X2584 (16:9) 166 332 499 - 26 32 33
Photo 8M 3872X2176 (16:9) 232 464 696 - 29 35 36
5M 3008X1688 (16:9) 376 752 1,129 - 32 38 39
2M 1920X1080 (16:9) 850 1,703 2,550 - 36 42 42
9M 3056X3056 (1:1) 210 420 630 - 32 34 35
6.7M 2592X2592 (1:1) 288 576 864 - 34 37 37
4M 2000X2000 (1:1) 470 940 1,411 - 38 40 40
1.6M 1280X1280 (1:1) 1,041 2,083 3,121 - 42 43 43
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Cautions when using memory cards

» Do not remove the memory card or turn off your camera while the
lamp is blinking, as this may damage your data.

* When the lifespan of a memory card has expired, you cannot store
any more photos on the card. Use a new memory card.

» Avoid using or storing memory cards near strong magnetic fields.

» Avoid using or keeping memory cards in areas with high temperature,
high humidity, or corrosive substances.

« When you carry a memory card, use a case to protect the card from
electrostatic discharges.

« Transfer important data to other media, such as a hard disk, CD, or
DVD.

a

* When you use the camera for an extended period, the memory
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Appendix

Use only Samsung-approved batteries.

Battery specifications

Model BP1310

Type Lithium-ion battery
Cell capacity 1,300 mAh
Voltage 7.4V

Charging time _
(when the camera is switched off) Approx. 150 min

Battery life

Shooting mode ‘ Average time / Number of photos
Photos Approx. 200 min/Approx. 400 photos
Videos Approx. 130 min

« The figures above are based on Samsung’s test standards. Your
results may differ depending on your actual usage.

+ Available shooting time differs depending on background, shooting
interval, and use conditions.

« Several videos were recorded in succession to determine the total
recording time.
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Notes about charging the battery

If the indicator light is off, make sure that the battery is inserted
correctly.

When the battery is completely discharged, charge it at least 10
minutes before using it with your camera.

Using the flash or recording videos depletes the battery more quickly.
Charge the battery until the indicator light turns green.

If the indicator light blinks orange or does not illuminate, reconnect the
cable, or remove the battery and insert it again.

If you charge the battery when the cable is overheated or the
temperature is too high, the indicator light may turn orange. Charging
will start when the battery cools down.

Do not pull on the power supply cord to disconnect the plug from the
power outlet. This may cause a fire or electric shock.

Do not bend or place heavy objects on the AC cable. Doing so may
damage the cable.

Personal injury or death can occur if the battery is handled carelessly or
improperly. For your safety, follow these instructions for proper battery
handling:

The battery can ignite or explode if not handled properly. If you notice

any deformities, cracks, or other abnormalities in the battery, immediately
discontinue use of the battery and contact your manufacturer.

Use only authentic, manufacturer-recommend battery chargers and
adapters and charge the battery only by the method described in this user
manual.

Do not place the battery near heating devices or expose to excessively
warm environments, such as the inside of an enclosed car in the
summertime.

Do not place the battery in a microwave oven.

Avoid storing or using the battery in hot, humid places, such as spas or
shower enclosures.

Do not rest the device on flammable surfaces, such as bedding, carpets,
or electric blankets for a prolonged period.

When the device is switched on, do not leave it in any confined space for a
prolonged period.

Do not allow battery terminals to come in contact with metallic objects,
such as necklaces, coins, keys, or watches.
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¢ Use only authentic, manufacturer-recommended, Lithium-ion replacement
batteries.

* Do not disassemble the battery or puncture the battery with any sharp
object.

¢ Avoid exposing the battery to high pressure or crushing forces.

¢ Avoid exposing the battery to major impacts, such as dropping it from high
places.

* Do not expose the battery to temperatures of 60 °C (140 °F) or above.

¢ Do not allow the battery to come in contact with moisture or liquids.

¢ Battery shall not be exposed to excessive heat such as sunshine, fire or the
like.

Disposal guidelines

¢ Dispose of the battery with care.

¢ Do not dispose of the battery in a fire.

¢ Disposal regulations may differ by country or region. Dispose of the battery
. . . s
in accordance with all local and federal regulations. ~ 5

Guidelines for charging the battery

|
|

Charge the battery only by the method described in this user manual. The =

battery can ignite or explode if not charged properly. @“ @
an
~
(0 *
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If you are having trouble with your device, try these troubleshooting
solutions before contacting a service professional.

When you leave your camera at a service center, be sure to also leave the
/ other components that may have contributed to the malfunction, such as the
memory card and battery.

Situation ‘ Suggested remedies

Cannot turn on the
camera

Ensure that the battery is inserted.
Ensure that the battery is inserted correctly.
Charge the battery.

The power turns off
suddenly

Charge the battery.

Your camera may be in Power save mode.

(p. 97)

The camera may be turned off automatically
to prevent the memory card from being
damaged due to excessive heat. Turn on your
camera again.

Cannot capture
photos

Situation ‘ Suggested remedies

» There is no space on the memory card.
Delete unnecessary files or insert a new card.

* When the AF Priority function is turned on,
you cannot capture a photo unless the focus
is set correctly. Set AF Priority to Off or focus
on the subject correctly. (p. 64)

* Format the memory card.

* The memory card is defective. Get a new
memory card.

* The memory card is locked. Unlock the card.
(p. 122)

* Ensure that the camera is switched on.
* Charge the battery.
* Ensure that the battery is inserted correctly.

The camera freezes

Remove the battery and insert it again.

The camera is losing
battery power quickly

The battery may lose power more quickly in
low temperatures (below 0° C/32°F). Keep the
battery warm by putting it into your pocket.
Using the flash or recording videos depletes
the battery quickly. Recharge if needed.
Batteries are consumable parts that must be
replaced over time. Get a new battery if the
battery life is diminishing quickly.

The camera heats up

While using the camera, it may heat up. This
is normal and should not affect your camera’s
lifespan or performance.

The flash fires
unexpectedly

The flash may fire due to static electricity. The
camera is not malfunctioning.

The flash does not
work

* The flash option may be set to Off. (p. 70)
* You cannot use the flash in some modes.

The date and time are
incorrect

Set the date and time in the display settings
menu.
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Situation ‘ Suggested remedies

The display or
buttons do not work

Remove the battery and insert it again.

The memory card has
an error

The memory card has not been formatted or
has become corrupt. Format the card.

Cannot display files

If you change the name of a file, your camera
may not play the file (the name of the file should
meet the DCF standard). If you encounter this
situation, display files on your computer.

The photo is blurry

* Ensure that the focus option you set is
suitable for the kind of shot you are capturing.

* Use a tripod to prevent your camera from
shaking.

* Ensure that the lens is clean. If not, clean the
lens. (p. 120)

The colors in the
photo do not match
the actual scene

An incorrect White Balance can create
unrealistic color. Select the proper White
Balance option to suit the light source. (p. 54)

The photo is too
bright

Your photo is overexposed.

» Adjust the aperture value or the shutter
speed.

* Adjust the ISO sensitivity. (p. 53)

* Turn off the flash. (p. 70)

» Adjust the exposure value. (p. 77)

Situation ‘ Suggested remedies

Your photo is underexposed.

» Adjust the aperture value or the shutter
speed.

* Adjust the ISO sensitivity. (p. 53)

* Turn on the flash. (p. 70)

» Adjust the exposure value. (p. 77)

The photo is too dark

Photos are distorted

This camera can have minute distortion when
using a wide-angle lens that enables shooting
with a wide angle of view. This is normal, and
does not cause malfunction.

Playback screen does
not appear on the
connected external
device

* Ensure that A/V or HDMI cable is properly
connected to the external monitor.

* Ensure that the memory card is properly
recorded.

Your computer does
not recognize your
camera

* Ensure that the USB cable is connected
correctly.

* Ensure that your camera is switched on.

* Ensure that you are using a supported
operating system.

Your computer
disconnects the
camera while
transferring files

The file transfer may be interrupted by static
electricity. Disconnect the USB cable and
connect it again.
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Situation ‘ Suggested remedies Situation ‘ Suggested remedies

Depending on the software you use, video files » Set the date and time again.
Your Computer may not play To play video files Captured with The date & time ¢ This screen appears when the camera’s
cannot play videos your camera, install and use the Intelli-studio settings screen internal power source is completely
program on your computer. (p. 110) appears when you discharged. Insert a fully charged battery and
. L « End Intelli-studio and restart the program. power on the camera wait at least 72 hours in power off status for
Intelli-studio is not ) . ; the internal power source to be recharged.
* You cannot use Intelli-studio on Macintosh

functioning properly

computers.
Cannot set the DPOF | ) | ot set the DPOF for RAW files.
for RAW files
» Subject is not in focus. When the subject is
outside the AF area, shoot by moving the
subject inside the AF area and half pressing
Auto Focus does not [Shutter].
work » Subject is too close. Step back from the

subject and shoot.

e The focus mode is set to MF. Switch the
mode to AF.

AEL feature does not work in M, @, Giarr,
(2@, (MM, and SCENE modes. Select another

AEL feature does not

work mode to use this feature.
* Ensure that the lens is properly mounted.
Lens does not work * Remove the lens from the camera and re-

mount it.

External flash or GPS | Ensure that the external device is properly
does not work mounted and turned on.
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Image Sensor
Type CMOS

Sensor size 23.4 X 15.6 mm

Effective pixels Approx. 14.6 mega-pixels

Total pixels Approx. 15.1 mega-pixels

Color filter RGB primary color filter

Lens Mount

Type Samsung NX Mount

Available lens Samsung lenses

Image Stabilization
Type Lens shift (depends on lens)
Mode Mode 1/ Mode 2 / Off

Distortion Correct

LLens Distortion Correct on/off (depends on lens)

i-Function

i-Scene (depends on lens)

Dust Reduction

Super sonic drive

Display

Type AMOLED

Size 3.0" (7.6 cm)

Resolution VGA (640X480) 614 k dots (PenTile)

Field of view Approx. 100 %

User display Icons, Grid Line, Histogram

Type EVF (Electronic Viewfinder)

Resolution VGA (640X480) Approx. 921 k dots
Field of view Approx. 100 %

Magnification Approx. 0.86 X (APS-C, 50 mm, -1 m™)
Eye point Approx. 20.2 mm

Diopter adjustment

Focusing

Type

Approx. -4.0+2.0 m™

Contrast AF

Focusing point

 Selection: 1 point (free selection)

e Multi: Normal 15 points, Close up 35
points

* Face detection: Max. 10 faces

Mode

Single AF, Continuous AF, Manual Focus

AF Assist Lamp

Green LED

Shutter

Type

Electronically controlled vertical-run focal
plane shutter
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Speed

e Auto: 1/4,000-30 sec.

¢ Manual: 1/4,000-30 sec.
(1/3 or 1/2 EV Step)

* Bulb (time limit: 8 min)

Exposure

Metering system

TTL 247 (19 X 13) Block segment

Metering: Multi, Center-weighted, Spot

Metering range: EV 0-18
(1ISO100-30 mm, F2.0)

Compensation

+3 EV (1/3 or 1/2 EV Step)

AE lock

AEL button

ISO equivalent

» 1 Step: Auto, ISO 100, ISO 200, ISO 400,
ISO 800, ISO 1600, ISO 3200

* 1/3 Step: Auto, ISO 100, ISO 125,
ISO 160, ISO 200, ISO 250, ISO 320,
ISO 400, ISO 500, ISO 640, ISO 800,
ISO 1000, ISO 1250, ISO 1600, ISO 2000,
ISO 2500, ISO 3200

Mode

Single, Continuous, Burst, Timer, Bracket
(auto exposure, White Balance, Picture
Wizard)

Continuous shooting

* JPEG: 3 shots per second
(Max. 6 shots-with Lens Distortion Correct
on, Max. 10 shots-with Lens Distortion
Correct off)

* RAW: 3 shots per second

Burst shooting

* 10, 15, or 30 frames per second
* 30 shots per shutter-press

Bracket shooting

Auto exposure bracketing (=3EV),
White Balance bracketing,
Picture Wizard bracketing

Self-timer

2-30 sec. (1 second interval)

Shutter release
Flash

SRINXO1 (optional)

Type

TTL auto pop-up flash

Mode

Smart Flash, Auto, Auto + Red, Fill in, Fill-in
Red, 1st Curtain, 2nd Curtain, Off

Guide number

11 (based on ISO 100)

Angle of view 28 mm (35 mm film equivalent)
Sync speed Less than 1/180 sec.
Flash EV -2-+2 EV (0.5 EV Step)

External flash

Optional Samsung external flashes: SEF15A,
SEF20A, SEF42A

Syncro
White Balance

Hot shoe

Mode

Auto WB, Daylight, Cloudy, Fluorescent
White, Fluorescent NW, Fluorescent Daylight,
Tungsten, Flash WB, Custom Set, Color
Temp. (Manual)

Micro adjustment

Amber/Blue/Green/Magenta 7 steps
respectively
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Dynamic Range Expansion

Smart range on/off

Picture Wizard

Standard, Vivid, Portrait, Landscape, Forest,

Mode Retro, Cool, Calm, Classic, Custom1,
Custom?2, Custom3
Parameter Contrast, Sharpness, Saturation, Color

Shooting

Smart Auto, Program, Shutter Priority,

Mode Aperture Priority, Manual, Lens Priority,
Sound picture, Panorama, Scene, Movie
Beauty Shot, Portrait, Children, Sports,
S Backlight, Close Up, Text, Landscape,
cene mode

Sunset, Dawn, Beach & Snow, Night,
Fireworks

Sound picture

JPEG only

Recordable time (before and after shooting,
5 or 10 seconds respectively)

Size

* JPEG (3:2): 14M (4592X3056),
10M (3872X2592), 6M (3008X2000),
2M (1920X1280), 1.4M (1472X976,
Burst mode only)

o JPEG (16:9): 12M (4592X2584),
8M (3872X2176), 5M (3008X1688),
2M (1920X1080)

* JPEG (1:1): 9M (3056X3056),
6.7M (2592X2592), 4M (2000X2000),
1.6M (1280X1280)

* RAW: 14M (4592X3056)

Quality Super Fine, Fine, Normal

RAW standard SRW

Color space sRGB, Adobe RGB

Type MP4 (H.264)

Format Movie: H.264, Sound: AAC
Movie AE mode Program, Aperture Priority

Movie clip Audio on/off (Shooting time: up to 25 min)
Size 1280X720, 640X480, 320X240
Frame rate 30 frames per second

Sound Mono

Edit Still image capture, Time trimming

Playback

Type

Single image, Thumbnails (3/9/20), Slide
show, Movie

Highlight warning

Available

Edit

Red-eye Fix, Backlight, Photo Style Selector,
Resize, Rotate, Face Retouch, Smart Filter

Smart filter

Miniature, Fish-Eye, Defog, Halftone Dots,
Soft Focus
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Smart filter size

« JPEG (3:2): 6M (3008X2000),
oM (1920X1280), VGA (40X424)
« JPEG (16:9): 5M (3008X1688),
2M (1920X1080), VGA (840X360)
« JPEG (1:1): 4M (2000X2000),
1.6M (1280X1280), VGA (480X480)

Photo style selector

Soft, Vivid, Forest, Autumn, Misty, Gloomy,
Classic

Storage

External memory (optional): SD card

Media (up to 4 GB guaranteed), SDHC card
(up to 32 GB guaranteed)
File format RAW (SRW), JPEG (EXIF 2.21), DCF,

Direct Printing

DPOF 1.1, PictBridge 1.0

PictBridge
GPS
Tvoe Geo-tagging with optional GPS Module
P (WGS 84)
Feature * Location name (English and Korean only)

Interface

* Google Map link (with Intelli-studio)

Digital output

USB 2.0 (HI-SPEED)

Video output

NTSC, PAL (selectable)
HDMI 1.3: (1080i, 720p, 576p/480p)

Included

DC 9.0V, 1.5 A (100-240 V)

External release

DC power input

Power Source

* Rechargeable battery: BP1310
(1,300 mAh)

e Charger: BC1310

* AC adapter: ADONXO1 (optional)

* The power source may differ depending
on your region.

Type

Dimensions (W X H X D)

123 X 87 X 39.8 mm (without protrusions)
Weight

353 g (without battery and memory card)

Operating Temperature
0-40 °C

Operating Humidity
5-85 %

Software

Intelli-studio, Samsung RAW Converter

* This specifications can change without notice to upgrade a performance.
* Other brands and products names are trademarks of respective owners.
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Lens Name

Focus Length

SAMSUNG 18-55 mm F3.5-5.6 OIS ||

18-55 mm (equivalent to
27.7-84.7 mm in 35 mm format)

SAMSUNG 20-50 mm F3.5-5.6 ED

20-50 mm (equivalent to 30.8-77 mm in
35 mm format)

| SAMSUNG 20 mm F2.8

20 mm (equivalent to 30.8 mm in
35 mm format)

Elements in Group

12 elements in 9 groups
(1 aspheric lens included)

9 elements in 8 groups (1 aspheric lens,
1 low dispersive lens included)

6 elements in 4 groups
(1 aspheric lens included)

Angle of View 75.9°-28.7° 70.2°-31.4° 70.2°
F3.5-5.6 (minimum: F22), F3.5-5.6 (minimum: F22), F2.8 (minimum: F22),
Aperture (Number of Blades: 7, (Number of Blades: 7, (Number of Blades: 7,
Circular Aperture Diaphragm) Circular Aperture Diaphragm) Circular Aperture Diaphragm)
Mount Type Samsung NX mount Samsung NX mount Samsung NX mount
Optical Image Stabilizer Included Not included Not included
Minimum Focus Distance | 0.28 m-infinity 0.28 m-infinity 0.17 m-infinity

Maximum Magnification

Approx. 0.22 X

Approx. 0.22 X

Approx. 0.18X

Supported (Beauty Shot, Portrait,

Supported (Beauty Shot, Portrait,

Supported (Backlight, Landscape,

ocene o Dawn, Beach & Snow, Mg | Dawn, Boach & Snow. Nt | Sunset, Dawn, Beach & Sriow, Nighy
Lens Hood Included Not included Not included

Filter Size 58 mm 40.5 mm 43 mm

Max. Diameter X Length | 63 X 65.1 mm 64 X 39.8 mm 62.2 X 24.5 mm

Weight Approx.198 g (without hood) Approx. 119 g Approx. 89 g

Operating Temperature 0-40 °C 0-40 °C 0-40 °C

Operating Humidity 5-85 % 5-85 % 5-85 %
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Lens Name

Focus Length

| SAMSUNG 30 mm F2
30 mm (equivalent to 46.2 mm in 35 mm format)

| SAMSUNG 50-200 mm F4-5.6 ED OIS II
50-200 mm (equivalent to 77-308 mm in 35 mm format)

Elements in Group

5 elements in 5 groups (1 aspheric lens included)

17 elements in 13 groups (2 low dispersive lenses included)

Angle of View 50.2° 31.4°-8.0°

Aperture EZ (minumum: F22), (Number of Blades: 7, Circular Aperture F4-5.6 (mirjimum: F22), (Number of Blades: 7, Circular
iaphragm) Aperture Diaphragm)

Mount Type Samsung NX mount Samsung NX mount

Optical Image Stabilizer Not Included Included

Minimum Focus Distance 0.25 m-infinity 0.98 m-infinity

Maximum Magnification Approx. 0.16 X Approx. 0.2 X

i-Scene Mode Not supported Supported (Beauty Shot, Portrait, Children, Backlight, Sports)
Lens Hood Optional Included

Filter Size 43 mm 52 mm

Max. Diameter X Length 61.5X21.5mm 70X 100.5 mm

Weight

Approx. 85 g (without hood)

Approx. 417 g (without hood)

Operating Temperature

0-40 °C

0-40°C

Operating Humidity

5-85 %

5-85 %

a Lens may differ from your actual items.
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AdobeRGB

Adobe RGB is used for commercial printing and has a larger color range
than sRGB. Its wider range of colors helps you to easily edit photos on a
computer.

AEB (Auto Exposure Bracket)

This feature automatically captures several images at different exposures
to help you capture a properly-exposed image.

AEL/AFL (Auto Exposure Lock/Auto Focus Lock)

These features help you lock the exposure or focus on which you want
to focus or calculate the exposure.

AF (Auto Focus)

A system that automatically focuses the camera lens on the subject.
Your camera uses the contrast to focus automatically.

AMOLED (Active-matrix organic light-emitting diode) /
LCD (Liquid Crystal Display)

AMOLED is a visual display that is very thin and light, as it does not
need backlighting. LCD is a visual display commonly used in consumer
electronics. This display needs a separate backlight, such as CCFL or
LED, to reproduce colors.

Aperture

The aperture controls the amount of light that reaches the camera’s
Sensor.

Camera shake (Blur)

If the camera is moved while the shutter is open, the entire image may
appear blurred. This occurs more often when the shutter speed is slow.
Prevent camera shake by raising the sensitivity, using the flash, or using
a faster shutter speed. Alternatively, use a tripod or the OIS function to
stabilize the camera.

Color space

The range of colors that the camera can see.
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Color temperature

Color Temperature is a measurement in degrees Kelvin (K) that indicates
the hue of a specific type of light source. As the color temperature
increases, the color of the light source has a more bluish quality. As the
color temperature decreases, the color of the light source has a more
reddish quality. At 5,500 degrees Kelvin, the color of the light source is
similar to the sun at midday.

Composition

Composition in photography means arranging objects in a photo.
Usually, abiding by the rule of thirds leads to a good composition.

DCF (Design rule for Camera File system)

A specification to define a file format and file system for digital cameras
created by the Japan Electronics and Information Technology Industries
Association (JEITA).

Depth of field

The distance between the nearest and farthest points that can be
acceptably focused in a photograph. Depth of field varies with lens
aperture, focal length, and distance from the camera to the subject.
Selecting a smaller aperture, for example, will increase the depth of field
and blur the background of a composition.

DPOF (Digital Print Order Format)

A format for writing printing information, such as selected images

and number of prints, on a memory card. DPOF-compatible printers,
sometimes available at photo shops, can read the information from the
card for convenient printing.

EV (Exposure Value)

All the combinations of the camera’s shutter speed and lens aperture
that result in the same exposure.

EV Compensation

This feature allows you to quickly adjust the exposure value measured
by the camera, in limited increments, to improve the exposure of your
photos.

Exif (Exchangeable Image File Format)

A specification to define an image file format for digital cameras created
by the Japan Electronic Industries Development Association (JEIDA).
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Exposure

The amount of light allowed to reach the camera’s sensor. Exposure is
controlled by a combination of the shutter speed, the aperture value,
and ISO sensitivity.

Flash

A speed light that helps to create adequate exposure in low-light
conditions.

Focal length

The distance from the middle of the lens to its focal point(in millimeters).
Longer focal lengths result in narrower angles of view and the subject is
magnified. Shorter focal lengths result in wider angles of view.

Histogram

A graphical representation of the brightness of an image. The horizontal
axis represents the brightness and the vertical axis represents the
number of pixels. High points at the left (too dark) and right (too bright)
on the histogram indicate a photo that is improperly exposed.

H.264/MPEG-4

A high-compression video format established by international standard
organizations ISO-IEC and ITU-T. This codec is capable of providing
good video quality at low bit rates developed by the Joint Video Team

(V).

Image sensor

The physical part of a digital camera that contains a photosite for each
pixel in the image. Each photosite records the brightness of the light
that strikes it during an exposure. Common sensor types are CCD
(Charge-coupled Device) and CMOS (Complementary Metal Oxide
Semiconductor).

ISO sensitivity

The sensitivity of the camera to light, based on the equivalent film speed
used in a film camera. At higher ISO sensitivity settings, the camera
uses a higher shutter speed, which can reduce blur caused by camera
shake and low light. However, images with high sensitivity are more
susceptible to noise.



appendix > GlOSSAry

JPEG (Joint Photographic Experts Group)

A lossy method of compression for digital images. JPEG images are
compressed to reduce their overall file size with minimal deterioration of
the image resolution.

Metering

The metering refers to the way in which the camera measures the
quantity of light to set the exposure.

MF (Manual Focus)

A system that manually focuses the camera lens on the subject. You
can use the focus ring to focus on a subject.

MJPEG (Motion JPEG)

A video format which is compressed as a JPEG image.

Noise

Misinterpreted pixels in a digital image that may appear as misplaced or
random, bright pixels. Noise usually occurs when photos are shot with a
high sensitivity or when a sensitivity is automatically set in a dark place.

NTSC (National Television System Committee)

A video color encoding standard used most commonly in Japan, North
America, the Philippines, South America, South Korea, and Taiwan.

Optical zoom

This is a general zoom which can enlarge images with a lens and does
not deteriorate quality of images.

PAL (Phase Alternate Line)

A video color encoding standard used in numerous countries throughout
Africa, Asia, Europe, and the Middle East.
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Quality

An expression of the rate of compression used in a digital image. Higher
quality images have a lower rate of compression, which usually results in
a larger file size.

RAW (CCD raw data)

The original, unprocessed data, collected directly from the camera’s
image sensor. White Balance, contrast, saturation, sharpness, and
other data can be manipulated with editing software before the image is
compressed into a standard file format.

Resolution

The number of pixels present in a digital image. High resolution images
contain more pixels and typically show more detail than low resolution
images.

Shutter speed

Shutter speed refers to the amount of time it takes to open and close
the shutter, and it is an important factor in the brightness of a photo, as
it controls the amount of light which passes through the aperture before
it reaches the image sensor. A fast shutter speed allows less time to let
light in and the photo becomes darker and more easily freezes subjects
in motion.

sRGB (Standard RGB)

International standard of colour space established by the IEC
(International Electrotechnical Commission). This is defined from colour
space for PC monitors and is also used as the standard colour space
for Exif.

Vignetting

A reduction of an image’s brightness or saturation at the periphery
(outer edges) compared to the center of the image. Vignetting can draw
interest to subjects positioned in the center of an image.

White Balance (color balance)

An adjustment of the intensities of colors (typically the primary colors
red, green, and blue), in an image. The goal of adjusting the White
Balance, or color balance, is to correctly render the colors in an image.
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HDMI cable

You can view high-definition photos and
videos by connecting the camera to an
HDMI-compatible monitor with the HDMI
(HDMI type C) cable.

Camera bag

You can purchase the camera bag
separately.

Memory card

This camera accepts SD (Secure Digital) and
SDHC (Secure Digital High Capacity) memory
card.

Adapter

You can charge the battery by connecting
the adapter to the power outlet.

Strap
You can additionally purchase the straps.

Battery pack
AN cable / You can purchase additional battery packs.
You can connect to other devices by using

the A/V cable.

* These illustrations may differ from your actual items. Refer to the user
/ manuals of these optional accessories for details.
* Use only Samsung-approved accessories. Samsung is not responsible for
damage caused by using another manufacturer’s accessories.

Shutter release
Shutter release reduces shakiness when
used with a tripod.

Filter

You can create different colored effects by
attaching filters to your lens.
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Correct Disposal of This Product
(Waste Electrical & Electronic Equipment)

(Applicable in the European Union and other European
countries with separate collection systems)

This marking on the product, accessories or literature indicates that
the product and its electronic accessories (e.g. charger, headset, USB
cable) should not be disposed of with other household waste at the
end of their working life. To prevent possible harm to the environment
or human health from uncontrolled waste disposal, please separate
these items from other types of waste and recycle them responsibly to
promote the sustainable reuse of material resources. Household users
should contact either the retailer where they purchased this product,
or their local government office, for details of where and how they can
take these items for environmentally safe recycling. Business users
should contact their supplier and check the terms and conditions of the
purchase contract. This product and its electronic accessories should
not be mixed with other commercial wastes for disposal.

Correct disposal of batteries in this product

(Applicable in the European Union and other European
countries with separate battery return systems)

This marking on the battery, manual or packaging indicates that the
batteries in this product should not be disposed of with other household
waste at the end of their working life. Where marked, the chemical
symbols Hg, Cd or Pb indicate that the battery contains mercury,
cadmium or lead above the reference levels in EC Directive 2006/66.

If batteries are not properly disposed of, these substances can cause
harm to human health or the environment.

To protect natural resources and to promote material reuse, please
separate batteries from other types of waste and recycle them through
your local, free battery return system.

This Class [B] digital apparatus complies with Canadian ICES-003.

Dispose unwanted electronics through an approved recycler.
To find the nearest recycling location, go to our website:
www.samsung.com/recyclingdirect Or call, (877) 278 - 0799
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NOTE:

This equipment has been tested and found to comply with the limits for

a Class B digital device, pursuant to part 15 of the FCC Rules. These

limits are designed to provide reasonable protection against harmful

interference in a residential installation. This equipment generates, uses

and can radiate radio frequency energy and, if not installed and used in

accordance with the instructions, may cause harmful interference to radio

communications. However, there is no guarantee that interference will

not occur in a particular installation. If this equipment does cause harmful

interference to radio or television reception, which can be determined by

turning the equipment off and on, the user is encouraged to try to correct

the interference by one or more of the following measures:

* Reorient, or relocate, the receiving antenna.

* Increase the distance between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to
which the receiver is connected.

» Consult the dealer or an experienced radio / TV technician for help.

CAUTION:

Changes or modifications not expressly approved by the manufacturer
responsible for compliance could void the user’s authority to operate the
equipment.

Declaration of Conformity

Trade Name : Samsung Electronics America, Inc.

Model No. : Samsung NX11

Responsible Party : Samsung Electronics America, Inc.

Address : 85 Challenger Road, Ridgefield Park, NJ 07660
Telephone No. : 1-800-SAMSUNG (726-7864)

This device complies with Part 15 of the FCC Rules.

Operation is subject to the following two conditions:

(1) This device may not cause harmful interference, and (2) this device
must accept any interference received, including interference that may
cause undesired operation.




Please refer to the warranty that came with your product
or visit our website www.samsung.com for after-sales service or inquiries.


www.samsung.com
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